
Оценочные материалы по информатике 10 - 11 класс 

 

Оценочные средства 

Для достижения планируемых результатов обучения используются следующие 

формы текущего контроля знаний и умений учащихся и промежуточной аттестации: 

1. Практические работы на компьютере.  

2. Творческие работы. 

Общие критерии оценивания результатов учебной деятельности: 

Отметка «5» (отлично) - ученик обнаруживает усвоение обязательного уровня и 

уровня повышенной сложности учебных программ; выделяет главные положения в 

учебном материале и не затрудняется при ответах на видоизмененные вопросы; свободно 

применяет полученные знания на практике; не допускает ошибок в воспроизведении 

изученного материала, а также в письменных и практических работах, которые выполняет 

уверенно и аккуратно. 

Отметка «4» (хорошо) - ученик обнаруживает усвоение обязательного и частично 

повышенного уровня сложности учебных программ, отвечает без особых затруднений на 

вопросы учителя; умеет применять полученные знания на практике; в устных ответах не 

допускает серьезных ошибок, легко устраняет отдельные неточности с помощью 

дополнительных вопросов учителя, в письменных и практических работах делает 

незначительные ошибки. 

Отметка «3» (удовлетворительно) - ученик обнаруживает усвоение обязательного 

уровня учебных программ, но испытывает затруднения при его самостоятельном 

воспроизведении и требует 

дополнительных уточняющих вопросов учителя; предпочитает отвечать на 

вопросы воспроизводящего характера и испытывает затруднение при ответах на 

видоизмененные вопросы; допускает ошибки в письменных и практических работах. 

Отметка «2» (неудовлетворительно) - у обучающегося имеются отдельные 

представления об изученном материале, но все же большая часть обязательного уровня 

учебных программ не усвоена, в письменных и практических работах ученик допускает 

грубые ошибки. 

При оценке результатов деятельности учащихся учитывается характер допущенных 

ошибок: существенных, несущественных. 

Критерии и нормы оценивания практической работы 

Отметка«5»:     

а) выполнил работу в полном объеме с соблюдением необходимой 



последовательности ее проведения; 

б) самостоятельно и рационально выбрал и загрузил необходимое программное 

обеспечение, все задания выполнил в условиях и режимах, обеспечивающих получение 

результатов и выводов с наибольшей точностью; 

в) в представленном отчете правильно и аккуратно выполнил все записи, таблицы, 

рисунки, чертежи, графики, вычисления и сделал выводы. 

 Отметка«4»:работа выполнена правильно, с учетом 2-3 несущественных 

ошибок, 

исправленных самостоятельно по требованию учителя. 

 Отметка «3»: работа выполнена правильно не менее чем на половину, или 

допущена существенная ошибка. 

 Отметка«2»: в ходе работы допущены две (и более) существенные ошибки, 

которые учащийся 

не может исправить по учителя. 

 Отметка «1»: работа не выполнена. 

Критерии и нормы оценивания тестовой работы 

В качестве одной из основных форм контроля используется тестирование. До 

организации первого тестирования следует более детально познакомить учащихся с 

тестовыми заданиями, рассказать о системе оценивания, продемонстрировать бланк с 

тестовыми заданиями, дать подробную инструкцию по их выполнению, обратить 

внимание на временные ограничения. 

Для того чтобы настроить школьников  на вдумчивую работу с тестами, важно им 

объяснить правила, которых следует придерживаться при оценивании. Такой подход 

позволяет добиться вдумчивого отношения к тестированию, позволяет сформировать у 

школьников навыки самооценки и ответственного отношения к собственному выбору. 

 Отметка «5» выставляется, если правильно выполнено 86-100% заданий теста; 

 Отметка «4» выставляется, если правильно выполнено 71-85% заданий теста; 

 Отметка «3» выставляется, если правильно выполнено 50-70% заданий теста; 

 Отметка «2» выставляется, если правильно выполнено 11-49% заданий теста; 

 Отметка «1» выставляется, если правильно выполнено менее 10% заданий 

теста; 

Критерии оценивания творческих работ учащихся 

 Отметка «5» ставится при условии: 

- работа выполнялась самостоятельно; 

- материал подобран в достаточном количестве с использованием разных 



источников; 

- работа оформлена с соблюдением всех требований для оформления проектов; 

- защита творческой работы проведена на высоком и доступном уровне. 

 Оценка «4» ставится при условии: 

- работа выполнялась самостоятельно; 

- материал подобран в достаточном количестве с использованием разных 

источников; 

- работа оформлена с незначительными отклонениями от требований для 

оформления проектов; 

- защита творческой работы проведена хорошо. 

 Оценка «3» ставится при условии: 

- работа выполнялась с помощью учителя; 

- материал подобран в достаточном количестве; 

- работа оформлена с незначительными отклонениями от требований для 

оформления проектов; 

- защита творческой работы проведена удовлетворительно. 

 

1. Формы контроля и оценивания учебной дисциплины 

Результаты обучения (освоенные умения, усвоенные знания) 

Формы и методы контроля и оценки результатов обучения 

В результате освоения дисциплины обучающийся должен уметь: 

 выполнять построение геометрических примитивов; 

 выполнять установку локальных и глобальных привязок 

 производить построение геометрических объектов по сетке 

 использовать различные способы построения изображения 

в Adobe Photoshop, Corel Draw 

Контроль и корректировка устных ответов студентов 

Контроль выполнения практических работ 

 

В результате освоения дисциплины обучающийся должен знать: 

 основные правила и инструкции по охране труда и технике безопасности 

при работе с ПК; 

 основные понятия компьютерной графики; 

 способы визуализации изображений (векторный и растровый); 

 основные принципы моделирования на плоскости; 



 основные средства для работы с графической информацией. 

Проверка контрольной работы 

Проверка тестовых заданий 

Контроль выполнения практических работ 

Таблица 2 

Виды контроля 

Формы 

Итоговый контроль 

Тема 1 . Введение в компьютерную графику 

к/р №1 Тест «Введение в компьютерную графику» 

Практикум №1 «Знакомство с графическими редакторами, рассмотрение 

возможностей» 

Практикум №2 «Изучение цветовых моделей, управление цветом» 

Тема 2 . Растровая редактор 

К/р №2 «Растровый редактор» 

Практикум №3 «Изучение возможностей меню Adob Photoshop» 

Практикум №4 «Изучение возможностей меню Adob Photoshop» 

Практикум №5 «Изучение панели инструментов, цветовой палитры Adob 

Photoshop» 

Пр.6 «Создание декоративного текста» 

Пр.7 «Создание изображения в технике свободного рисования» 

Пр.8 «Простейшие приемы работы» 

Пр.9 «Создание коллажа 

Тема 3. Векторный редактор 

К/р №2 «Векторный редактор», 

Пр. 10 «Изучение возможностей меню Corel DRAW» 

Пр.11 «Изучение панели инструментов, цветовой палитры Corel DRAW» 

Пр.12 «Основы работы в программе Corel DRAW» 

Пр.13 «Создание декоративного текста» 

Пр.14 «Создание изображений в технике свободного рисования» 

Пр.15 «Создание визитки» 

Пр.16 «Создание поздравительной открытки» 

Промежуточная аттестация 

Контрольная работа 

Рубежный контроль (оценка за 1 и 2 полугодия) 



Отметка в журнале как округлённое по законам математики до целого числа 

среднее арифметическое текущих отметок, полученных обучающимся 

2. Оценка освоения теоретического курса учебной дисциплины 

2.1. Задания для оценки освоения раздела «Введение в компьютерную 

графику» 

Тест на тему Введение в компьютерную графику 

1. Векторное изображение формируется 

а) Из объектов 

б) Из точек 

в) Из рисунков 

г) Из пикселей 

 

2. При сканировании изображения будет получено 

а) Векторное изображение 

б) Растровое изображение 

в) Комбинированное изображение 

г) Фрактальное изображение 

 

3. Ступенчатый эффект на рисунке получается если: 

а) Увеличить векторное изображение 

б) Уменьшить векторное изображение 

в) Увеличить растровое изображение 

г) Уменьшить растровое изображение 

 

4. При уменьшении растрового изображения 

а) Качество не изменяется 

б) Качество улучшается 

в) Теряются мелкие детали 

г) Появляется ступенчатый эффект 

 

5. Необходимо создать эмблему, которая будет распечатываться на офисных документах, 

фирменных бланках и уличном баннере. Какой графический редактор использовать? 

а) Растровый 

б) Векторный 

в) Фрактальный 



г) Трехмерный 

 

6. Пиксель это: 

а) Точка 

б) Примитив 

в) Линия 

г) Фигура 

 

7. Размер изображения не зависит от: 

а) Количества цветов в палитре 

б) Типа изображения 

в) От яркости цветов на изображении 

г) Разрешения 

8. Битовая глубина цвета это: 

а) Количество цветов в палитре 

б) Общее количество цветов в изображении 

в) Объем всего изображения 

г) Количество бит для хранения информации о цвете 1 точки 

 

9. Битовая глубина измеряется 

а) В байтах 

б) В битах 

в) В Кбитах 

г) В Мбайтах 

 

10. Укажите характеристику векторного изображения 

а) Изображение строится из пикселей 

б) Изменение размера происходит без потери качества 

в) Каждая точка имеет свой цвет, яркость 

г) Хранится цвет и оттенок каждой точки изображения 

 

11. При использовании цифровой фото камеры будет получено 

а) Векторное изображение 

б) Растровое изображение 

в) Фрактальное изображение 



г) Трехмерное изображение 

 

12. Для кодирования цветных изображений на экране монитора используется: 

а) GBR модель 

б) True Color 

в) RGB модель 

г) RED модель 

 

13. Цветное изображение на экране монитора получается путем смешивания цветов: 

а) Красный зеленый синий 

б) Красный синий желтый 

в) Пурпурный синий желтый 

г) Желтый красный зеленый 

 

14. Видеопамять предназначена для: 

а) Быстродействия процессора 

б) Хранения двоичного кода изображения, выводимого на экран 

в) Хранения изображения выводимого на принтер 

г) Для временного хранения данных перед передачей его на принтер 

 

15. Для создания цветных изображений в графическом редакторе используется: 

а) СMYK модель 

б) HSB модель 

в) RGB модель 

г) HSV модель 

 

16. Самые распространенные форматы изображений, на web-страницах 

а) JPEG 

б) CDR 

в) GIF 

г) TIFF 

17. Битовая глубина цвета в изображении равна 8. Сколько цветов в палитре? 

а) 128 

б) 256 

в) 16 



г) 4 

Критерии оценок: 

Оценка «5» – правильно выполнено 17 заданий; 

Оценка «4» – правильно выполнено 14 заданий; 

Оценка «3» – правильно выполнено 10 заданий. 

 

2.2. Задания для оценки освоения раздела «Растровый редактор» 

 

Тест по теме «Растровый редактор» 

1. Графика, представляемая в памяти компьютера в виде совокупности точек, называется: 

1) Растровой. 

2) Векторной. 

3) Трехмерной. 

4) Фрактальной. 

 

2. Качество растрового изображения оценивается: 

1) Количество пикселей. 

2) Количество пикселей на дюйм изображения. 

3) Размером изображения. 

4) Количеством бит в сохраненном изображении. 

 

3. Элементарным объектов растровой графики является: 

1) То, что рисуется одним инструментом. 

2) Пиксель. 

3) Символ. 

4) Примитив. 

 

4. Выберите из предложенного списка расширения графических файлов. 

А) .doc 

Б) .gif 

В) . jpg 

Г) .exe 

Д) .bmp 

Е) .bak 

 



1) А В Д 2) Б В Г 3) Б В Д 4) В Д Е 

 

5. Для чего необходима палитра «История»? 

1) Содержит наборы инструментов с различными предустановленными параметрами. 

2) Позволяет отменять выполненные действия, включая и те, которые не отменяются 

посредством сочетания клавиш Ctrl+Z. 

3) Дает широкий круг возможностей выбора формы и размеров кисти. 

4) Дает общее представление об изображении, его цветовом решении, размерах и 

помогает при просмотре и редактировании. 

 

6. Изображения представленные посредством пикселей, то есть разложенные на элементы, 

называется: 

1) Растровым. 

2) Фрактальным 

3) Трехмерным 

4) Векторным 

 

7. Сетка, которую на экране образуют пиксели, называют: 

1) Видеопамять; 

2) Видеоадаптер; 

3) Растр; 

4) Дисплейный процессор. 

 

8. Одной из основных функций графического редактора является: 

1) Ввод изображений; 

2) Хранение кода изображения; 

3) Создание изображений; 

4) Просмотр и вывод содержимого видеопамяти. 

 

9. Кнопки панели инструментов, палитра, рабочее поле, меню образуют: 

1) Полный набор графических примитивов графического редактора; 

2) Среду графического редактора; 

3) Перечень режимов работы графического редактора; 

4) Набор команд, которыми можно воспользоваться при работе с графическим 

редактором. 



 

10. Пиксель на экране монитора представляет собой: 

1) Минимальный участок изображения, которому независимым образом можно задать 

цвет; 

2) Двоичный код графической информации; 

3) Электронный луч; 

4) Совокупность 16 зерен люминофора. 

 

Критерии оценок: 

 

Оценка 5 – 10 баллов 

Оценка 4 – 8 – 9 баллов 

Оценка 3 – 7 – 6 баллов 

Оценка 2 – 4 – 5 баллов 

 

ОТВЕТЫ 

 

№ вопроса 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

№ ответа 

1 

2 

2 

3 

2 

1 



3 

3 

2 

1 

 

2.3. Тест по теме: «Векторный редактор» 

 

I. Подберите к каждому термину левой колонки определение из правой: 

 

1. Представление графической информации в виде набора точек называется 

а) программа для создания и редактирования изображений, основывающая на принципах 

векторной графики 

2. CorelDraw – это 

б) построения фигуры от центральной точки в стороны 

3. Open Graphic означает 

в) просмотр 

4 

. Инструмент означает 

 

г) сектор, дугу 

5. При рисовании прямоугольников клавиша Shift используется для 

д) представления фигуры в виде правильного квадрата 

6. Команда View из строки меню означает 

е) многоугольник 

7. С помощью инструмента 

 

можно создать 

ж) управление 

 

з) открыть документ 

 

и) растровым 

 

к) спираль, диаграммную сетку 



 

II. Найдите наиболее подходящий вариант: 

 

1. Основными элементами окна CorelDraw являются: 

а) Строка заголовка, строка меню 

б) Стандартная панель инструментов 

в) Панель атрибутов, линейка 

г) Палитра цветов 

д) Все перечисленное 

3 

. Инструмент означает 

а) Форму 

б) Выбор 

в) Кривую 

г) Контур 

д) Заливку 

2. Команда Edit из строки меню означает 

а) Компоновка 

б) Просмотр 

в) Управление 

г) Редактирование 

д) Точечные изображения 

4. Фрактальная графика основана 

а) На математических вычислениях 

б) Представлении информации в виде пикселей 

в) Построении геометрических объектов 

г) На преобразовании текста 

д) Использовании коллекции Clipart 

 

III. Дополнить: 

1. Клавиша Ctrl используется для __________________________________ 

2. Содержание Контекстное меню находится в зависимости 

____________________________ 

3. Панель графики содержит ________________________ для создания объектов, 

позволяющих составить графическое произведение. 



 

 

Ответы для преподавателя: 

 

I. Подберите к каждому термину левой колонки определение из правой: 

 

1 

2 

3 

4 

5 

6 

7 

и 

а 

з 

е 

б 

в 

г 

 

II. Найдите наиболее подходящий вариант: 

 

1 

2 

3 

4 

д 

г 

в 

а 

 

III. Дополнить: 

1. Клавиша Ctrl используется для автоматического выравнивания фигур (квадрата, 

круга) 



2. Содержание Контекстное меню находится в зависимости от активного в данный 

момент инструмента 

3. Панель графики содержит все инструменты для создания объектов, позволяющих 

составить графическое произведение 

Практикум №1 

Тема: «Знакомство с графическими редакторами, рассмотрение 

возможностей» 

Цели: 

1. Познакомиться с графическими редакторами 

2. Рассмотреть возможности графических редакторов 

Компьютерная графика – это специальная область информатики, изучающая 

методы и средства создания и обработки изображений с помощью программно-

аппаратных вычислительных комплексов. 

Существует 3 вида компьютерной графики: растровая, векторная и фрактальная. 

Растровая графика представляет изображения в виде массива цифр. Поэтому при 

большом увеличении все точечные изображения выглядят как мозаика или сетка, 

состоящая из мельчайших ячеек. Такая сетка имеет название растровой карты (bitmap), ее 

единичный элемент называется пикселом. 

В связи со способом отображения информации растровое изображение часто 

сравнивают с мозаичным панно. 

При масштабировании растровых изображений возникают характерные искажения 

- "ступеньки" (aliasing или jaggies) (рис. 2). В большинстве растровых редакторов 

"ступеньки" удается частично убрать за счет специальных приемов (например, anti-

aliasing), но качество картинки при этом заметно снижается. 

Инструментальные средства растровых редакторов 

К фундаментальным инструментам растровой графики относятся такие 

инструменты обработки изображений, как: 

• инструменты выделения; 

• каналы и маски; 

• инструменты ретуширования; 

• гистограммы; 

• кривые; 

• инструменты для цветовой (цветовой баланс) и тоновой коррекции (уровни); 

• фильтры (спецэффекты); 

• слои. 



Кроме перечисленных инструментальных средств в состав растровых редакторов 

входит большое количество инструментов, названия которых ассоциируются с 

применением их в традиционной живописи и других приложениях: Аэрограф, Кисть, 

Карандаш, Ластик, Текст, Перо, Линия, Заливка, Пипетка, Трансформация, Масштаб, 

Рука, Рамка и т.п. Аналоги этих инструментов также имеются в большинстве векторных 

редакторов. 

 

1.2. Инструменты выделения. Маски 

Растровое изображение в отличие от векторного не содержит объектов, которые 

можно легко "расцепить" для выполнения их индивидуального редактирования. Поэтому 

для создания, например, коллажей (фотомонтажей) из отдельных фрагментов нескольких 

изображений каждый из них предварительно необходимо выделить. Данный процесс 

напоминает процедуру вырезание отдельных фрагментов из целостного изображения и 

называется процессом выделения (или обтравки) изображений. 

Выделение (Selection) - это область, ограниченная замкнутой рамкой выделения в 

виде движущейся пунктирной линии (контура), которая отмечает часть изображения, 

доступную для копирования, редактирования и выполнения различных типов 

преобразований. 

Маски - это один из базовых инструментов профессиональных растровых 

редакторов. 

Концепции маски и выделения тесно связаны, но несмотря на это понятие маски 

шире. Всякая маска включает в себя два типа областей: непрозрачные и прозрачные. 

Первые используются для защиты закрываемых ими частей изображений или объектов от 

нежелательных изменений. Они, собственно, и выполняют функцию маскирования. 

Прозрачные области можно рассматривать как отверстия в маске. Их используют для 

выделения фрагментов изображения или объекта, которые собираются модифицировать. 

Эти области называются выделенной областью, или выделением (обтравкой). 

Таким образом, маска не представляет собой нечто противоположное выделению. 

Противоположными свойствами обладают части маски, а именно защищенные и 

выбранные (выделенные) области. Соотношение между этими частями не является 

постоянным. В процессе работы над изображением оно может изменяться за счет 

увеличения доли одной из них и соответственно уменьшения доли другой. Для этой цели 

в растровых редакторах имеется специальный набор инструментов выделения. 

1.2.1. Маска и понятие альфа-канала 



Количество цветовых каналов определяется количеством базовых цветов в 

используемой цветовой модели. Так, изображение в формате Grayscale имеет один канал, 

в цветовых моделях RGB и L*a*b - три канала, а в модели CMYK - четыре канала. В 

растровых редакторах цветовые каналы генерируются автоматически при создании или 

открытии изображения. В Photoshop доступ к ним реализуется с помощью палитры 

Каналы, для отображения которой необходимо выбрать команду Window?Show Channels 

(Окно?Показать каналы). Подобные средства, но под иными названиями используются и в 

других растровых редакторах. 

Наряду с цветовыми каналами, число которых жестко определено типом 

используемой цветовой модели, в растровых редакторах возможно использование 

дополнительных каналов (альфа-каналов), количество которых ограничено только 

возможностями компьютера. Данная разновидность каналов широко используется для 

ретуширования, компоновки и локальной коррекции изображений. 

Назначение альфа-каналов тесно связано с понятием маски. Более того, фактически 

каждый такой канал представляет собой маску. Поэтому создание маски приводит к 

одновременному созданию альфа-канала, в который помещается "серое" изображение 

маски. 

Чтобы более четко раскрыть связь этих двух понятий, стоит остановиться на 

физической природе маски. Внешне маска напоминает трафарет. Говоря техническим 

языком, маска сама является изображением. Это изображение создается в модели 

Grayscale (Градации серого) и помещается поверх другого изображения, над фрагментами 

которого нужно выполнить определенные операции. Для любого пиксела маски значение 

оттенка серого цвета можно изменять в пределах 256 градаций серого (от 0 до 255). 

Область маски со значением цвета пикселов, равного 0 (черный), полностью защищает 

изображение от изменений. Область, пикселы которой имеют значение 255 (белый), 

полностью открыта для проведения изменений. Как уже отмечалось, такая область 

называется выбранной (выделенной). 

Как и цветовые, альфа-каналы хранятся в палитре Каналы. Для работы с альфа-

каналами предусмотрен ряд инструментов, доступ к которым осуществляется с помощью 

набора кнопок, размещенных в нижней части палитры Каналы. Краткий комментарий к 

назначению данных кнопок представлен в таблице 1. 

Таблица 1 

Кнопка N 

Наименование 

Назначение 



1 

Загрузить канал как выделение 

Создает слой - маску 

2 

Сохранить выделение как канал 

Созданная с помощью инструментов выделения маска является временным 

объектом, который пропадает после закрытия изображения. Нажатие данной кнопки 

позволяет сохранить маску в виде канала для последующей работы с ней 

3 

Создать новый канал 

Создает новый канал, в момент открытия представляющий собой сплошную маску, 

в которой с помощью инструментов выделения создается область выделения 

4 

Удалить текущий канал 

Удаляет активный в данный момент альфа-канал 

 

1.2.2. Инструменты и методы ретуширования 

Традиционно применение инструментов ретуширования изображений заключается 

в ретуши фотографий и восстановлении поврежденных изображений. Ретушь - коррекция 

изображения с целью устранения мелких дефектов, исправления тонального и цветового 

балансов. 

Наиболее часто используемыми средствами ретуширования являются: 

инструменты клонирования, инструменты размытия, инструменты Палец и Губка, 

инструменты Осветлитель и Затемнитель. Ниже будут рассмотрены функции, которые 

они выполняют. 

Для ретуширования изображений можно использовать некоторые из фильтров, 

несмотря на то, что большинство из них предназначено для применения к изображению 

специальных эффектов. В большинстве случаев для получения нужного эффекта их 

следует применять в совокупности с масками и выделениями. При работе с 

изображениями чаще всего приходится сталкиваться с дефектами локального характера, 

такими, как царапины, пятна и другие подобные искажения. В данном случае процесс 

ретуширования можно осуществить без применения выделений и масок, используя лишь 

инструментальные средства локального улучшения. 

Инструменты клонирования (Cloning Tools) предназначены для копирования 

деталей из одного места изображения (неповрежденного) в другое (поврежденное). 



Инструменты размытия (Blur) и повышения резкости (Sharpen) позволяют 

соответственно локально снижать или усиливать контраст между пикселами изображения. 

Инструменты Палец (Smudge) и Губка (Sponge) сглаживают различия между 

соседними оттенками в тех местах, где проходит кисть. 

Инструменты Осветлитель (Dodge) и Затемнитель (Burn) делают объекты более 

светлыми или тусклыми. 

1.3. Гистограмма. Оценка изображения 

Инструмент Гистограмма (Histogram) позволяет оценить разброс между 

минимальной и максимальной яркостью изображения (динамический диапазон). С его 

помощью становится возможным получить наглядное представление о распределении 

всех тонов в изображении. Поэтому гистограмма является одним из основных средств, 

используемых для контроля за тональными и цветовыми настройками изображения. 

Гистограммой называется график, отображающий распределение пикселов изображения 

по яркости. При построении этого графика по оси X откладываются значения яркостей в 

диапазоне от 0 (черный) до 255 (белый), а по оси Y - количество пикселов, имеющих 

соответствующее значение яркости. Анализ гистограммы позволяет понять, какие 

тоновые области изображения нуждаются в коррекции и в какой именно. Также с 

помощью гистограммы можно оценить тоновый диапазон изображения, то есть 

определить, какие тоновые области доминируют: тени (темные области), света (светлые 

области) или средние тона. 

Термины тени (shadows), средние тона (midtones) и света (highlights) используются 

в графических редакторах для обозначения соответственно темных, средних и светлых 

тонов изображения. 

1.3.1. Тоновая коррекция изображения 

Смысл тоновой коррекции заключается в придании изображению максимального 

динамического диапазона. Это напрямую связано с настройкой яркости изображения. 

Тон - уровень (градация, оттенок) серого цвета. Тоновое изображение имеет 

непрерывную шкалу градаций серого от белого до черного. Для одного канала число 

таких градаций равно 256. 

Для оценки и коррекции яркости и контрастности изображения, то есть для его 

тоновой коррекции, в профессиональных растровых редакторах имеется широкий набор 

средств. К ним относятся мощные универсальные инструменты Уровни (Levels) и Кривые 

(Curves), а также более простые, например Яркость/Контраст (Brightness/Contrast), 

предназначенные для устранения наиболее грубых дефектов типа недостаточной яркости 

или повышенной контрастности. 



1.3.2. Цветовая коррекция и цветовой баланс 

Цветокоррекция - изменение цветовых параметров пикселов (яркости, 

контрастности, цветового тона, насыщенности) с целью достижения оптимальных 

результатов. Наиболее распространенными средствами, которые используются для 

повышения качества цветных изображений, являются такие команды, как Баланс цветов 

(Color balance) и Оттенок/Насыщение (Hue/Saturation). 

Цветовой баланс - соотношение цветов в изображении. Регулировка цветового 

баланса позволяет усилить или ослабить один цвет за счет другого дополнительного 

(комплементарного ему). 

1.4. Фильтры (Plug-ins) и спецэффекты (Effects) 

В основном фильтры предназначены для создания специальных эффектов, таких, 

как имитация мозаики или какого-либо живописного стиля. С помощью трехмерных 

спецэффектов двухмерные графические программы способны преобразовать плоское 

двухмерное изображение в объемное. 

Фильтры и спецэффекты представляют собой небольшие программы, 

выполняющие заранее установленную последовательность команд. Они автоматически 

вычисляют значения и характеристики каждого пиксела изображения и затем 

модифицируют их в соответствии с новыми значениями. 

1.5. Работа со слоями 

Слой (layer) - дополнительный уровень (холст) для рисования, метафора 

прозрачной кальки. Каждый слой повторяет все параметры основного изображения - 

размеры, разрешение, цветовую модель, число каналов. При увеличении количества слоев 

возрастает размер изображения. Слои можно менять местами, делать невидимыми, а 

также можно рисовать только на одном слое, не затрагивая другие. 

Естественно, что если закрасить какой-либо слой сплошным рисунком или 

плотным сплошным цветом, то на нижних слоях не будет видно того, что там нарисовано. 

Однако компьютерная живопись позволяет сделать слой полупрозрачным, что открывает 

новые возможности в редактировании изображений. 

 

2. Контрольные вопросы: 

1. Какие виды графики вы знаете? 

 

2. Перечислите фундаментальные инструменты растровой графики. 

 

 



Практикум №2 

Тема: «Изучение цветовых моделей, управление цветом» 

Цель: Сформировать знания о цветовых моделях RGB,CMYK, LAB 

Цветовосприятие. Цветовой охват 

В общей сложности человеческий глаз различает несколько миллионов цветов. Не 

существует устройств, которые могут воспроизвести весь диапазон видимых оттенков, 

цвета изображения на экране или бумаге почти всегда отличаются от оригинальных. В 

процессе подготовки иллюстрации есть множество этапов. Исходная фотография 

переводится в электронную форму, затем обрабатывается в графических программах, 

отображается на экране монитора, затем печатается на принтере или офсетной машине. На 

каждом этапе цвета изображения получаются различным образом. Одни устройства могут 

воспринимать цвета — это глаза человека и некоторых животных, фотопленка, сканер. 

Другие воспроизводят цвета — офсетная машина, монитор, фотобумага. При каждом их 

этих процессов число цветов хоть и велико, но меньше всего диапазона. 

Цветовой охват – это диапазон цветов, который может быть воспроизведен, 

зафиксирован или описан каким-либо способом. 

Так, глаз не воспринимает цвета ультрафиолета и инфракрасного излучения. 

Фотоаппарат бессилен перед очень темными оттенками. Традиционная офсетная печать 

не передает очень светлые и яркие тона. Следовательно, цветовой охват монитора, 

офсетной машины и глаза разный, причем у глаза он наибольший. Часть из того, что 

воспринимает глаз, может передать монитор (на экране нельзя точно воспроизвести, 

например: чистые голубой или желтый цвета). Часть из того, что передает монитор, 

можно напечатать (например: при полиграфическом исполнении совсем не 

воспроизводятся цвета, составляющие которых имеют очень низкую плотность). Разность 

цветовых охватов устройств вывода и человеческого глаза представлена схемой (рис. 1.). 

Каждый из охватов может быть выражен моделью цвета. 



 

Рис. 1. Цветовой охват различных цветовых моделей 

Кодирование цвета 

Анализ цвета 

Проблема описания цвета решается представлением цветовой информации как 

цветового, или, точнее, светового потока. В общем случае цвет — это совокупность 

разных световых волн с преобладанием определенных частот. 

Строить описание цветовой информации на частотных характеристиках — задача 

очень сложная и малотехнологичная. Поэтому выполняется анализ цвета. 

Анализом цвета называется этап принудительного разделения светового потока с 

помощью совокупности фильтров. 

Каждый из используемых фильтров создает после себя однородный цветовой 

поток, т. е. тоновое изображение, которое достаточно легко фиксировать и кодировать — 

преобразовывать в цифровую форму. Фильтры необходимы для того, чтобы получить 

возможность фиксировать значения тона. Цвет измерить нельзя, зато можно измерить 

яркость (освещенность или тон). 

Сколько и каких фильтров достаточно для анализа цветовой информации? С 

практической точки зрения достаточно всего трех фильтров (красного, зеленого и синего 

цветов). Фильтры в данном случае — самые обычные, т. е. материальные (для них 

применяются пленки или стекло). 

Световой поток дублируется на три идентичных, которые проходят через три 

разных фильтра, а за каждым фильтром располагается устройство, фиксирующее яркость 

элемента дискретизации. В результате получаются три изображения в градациях серого 

(grayscale). Причем для полноцветных оригиналов все три изображения будут разными с 

точки зрения распределения тонов – от 0 до 255. Полученные изображения сохраняются в 

одном файле в форме так называемых цветовых каналов (color channels) (рис. 2). 



Поскольку это независимые изображения, они могут быть свободно представлены в виде 

отдельных документов (рис. 3). 

Каждое изображение в градациях серого (grayscale), входящее в цветной документ, 

имеет одно и то же разрешение. 

Итак, цветовые каналы в градациях серого необходимы для того, чтобы на этапе 

анализа избавиться от цвета и представить его в яркостных характеристиках. 

Синтез цвета 

При сохранении полноцветного изображения цветовые каналы составляют один 

документ. В любом таком изображении, как минимум, три условно цветовых канала. Но 

эти каналы являются цифровыми, поэтому невидимыми. Для того чтобы визуализировать 

их, необходимо обратиться к этапу синтеза цвета. 

Синтез— это соединение (мысленное или реальное) различных элементов объекта 

в единое целое (например, систему). 

 

 



Рис. 2. Цветовые каналы сканированного изображения 

Рис. 3. Цветовые каналы в виде отдельных документов 

На этапе анализа мы оперировали устройствами ввода информации, теперь следует 

перейти к устройствам вывода, которые позволяют синтезировать цвет из тех данных, 

которые были сохранены на этапе анализа. 

На примере монитора рассмотрим, каким же образом происходит синтез цвета. 

Каждый пиксель монитора, т. е. каждый элемент сетки монитора, состоит из трех более 

мелких элементов, которые представляют собой капли люминофора красного, зеленого и 

синего цветов. 

Люминофор — это органические и неорганические вещества, способные 

светиться (люминесцировать) под действием внешних факторов, например при 

облучении потоком электронов в электронно-лучевой трубке. 

В результате три монохромных изображения, сливаясь оптически, в совокупности 

формируют впечатление полноцветного изображения. Это означает, что реально на экране 

представлены оттенки только трех цветов, а многообразие различных цветов зрителю 

только кажется. 

Другим способом синтеза цвета является печать изображения. Диапазон этого 

способа очень широк: от печати на простейших струйных принтерах до 

высококачественного полиграфического исполнения. Переход к другому способу 

визуализации требует использования других цветовых моделей, что, безусловно, не 

проходит без проблем и искажений. 

Для математического описания цвета было предложено несколько цветовых 

моделей. Ни одна из них не была идеальна. Устройство моделей одинаково: в каждой из 

них принято несколько базовых компонентов, и каждый базовый компонент вносит вклад 

в создание конкретного цвета. 

Базовые компоненты модели называются каналами. 

Цвета, которые можно описать, используя данную модель, входят в ее цветовой 

охват. По-другому говорят, что эти цвета образуют цветовое пространство модели. Все 

модели имеют различный цветовой охват. 

Аппаратно-зависимые цветовые модели 

По принципу образования цветов в компьютерной графике выделяют две большие 

группы: аддитивную (RGB) и субтрактивную (CMYK). 

Модель RGB (Red — красный, Green — зеленый, Blue — синий) описывает 

излучаемые цвета. Базовыми компонентами модели являются три цвета лучей - красный, 

зеленый, синий. При восприятии цвета человеком именно они непосредственно 



воспринимаются глазом. Остальные цвета представляют собой смешение трех базовых в 

разных соотношениях. RGB — трехканалъная цветовая модель. В модели RGB кодирует 

изображение сканер и отображает экран монитора. 

Модель CMY описывает отраженные цвета (краски). Каналы CMY образуются в 

результате вычитания основных RGB-компонентов из белого цвета (то есть полного 

спектра). Это Cyan — голубой (белый минус красный), Magenta — пурпурный (белый 

минус зеленый) и Yellow — желтый (белый минус синий). 

Развитием модели CMY является модель CMYK. Она описывает реальный процесс 

цветной печати на офсетной машине и цветном принтере. Пурпурная, голубая и желтая 

краски (полиграфическая триада) последовательно наносятся на бумагу в различных 

пропорциях, и таким способом может быть репродуцирована значительная часть 

видимого спектра. В области черного и темных цветов наносится не цветная, а черная 

краска. Это четвертый базовый компонент, он введен для описания реального процесса 

печати. Черный компонент сокращается до буквы К (BlacK — черный или, по другой 

версии, Key — ключевой). CMYK — это четырехканальная цветовая модель. 

Модели RGB и CMYK являются аппаратно-зависимыми. Если речь идет о RGB, то 

значения базовых цветов (а также точка белого) определяются качеством примененного в 

вашем мониторе люминофора. В результате на разных мониторах одно и то же 

изображение выглядит неодинаково. Т.е. цвет зависит как от значений базовых 

составляющих, так и от параметров устройств: качества и марки печатной краски, свойств 

использованной бумаги, свойств люминофора и других параметров конкретного 

монитора, принтера или печатного пресса. 

Кроме того, существование разных моделей описания для излучаемых и 

отраженных цветов весьма неудобно при компьютерной подготовке цветных 

изображений. В полиграфический процесс входят системы, работающие как в модели 

RGB (сканер, монитор), так и CMYK (фотонабор, печатная машина). В процессе работы 

приходится преобразовывать цвет из одной модели в другую. Поскольку эти модели 

имеют разный цветовой охват, преобразование часто сопряжено с потерей части оттенков. 

Одной из основных задач при работе с цветными изображениями становится достижение 

предсказуемого цвета. Для этого создана система цветокоррекции CMS (система 

управления цветом). 

Программная система цветокоррекции CMS — Color Management 

System предназначена: 

     во-первых, достичь одинаковых цветов для всех частей полиграфического 

процесса, от сканера до печатного станка; 



     во-вторых — обеспечить стабильное воспроизведение цвета на всех выводных 

устройствах (например, на любом мониторе). 

Цветовая модель RGB. Кодирование цвета 

Интенсивность каждой из перечисленных составляющих RGB может варьировать 

от 0 до 255, образуя разные цвета и, обеспечивая доступ ко всем 256*256*256=16777216 

оттенков. 

Все цвета, входящие в данную цветовую модель, можно представить в виде куба. 

Если принять макс. излучение каждого люминофора за единицу и отложить их по 

осям X, Y и Z в декартовой системе координат, то получится графическая интерпретация 

рассматриваемого цветового пространства. Причем в точке, где все величины равны 

нулю, будет – черный цвет, там же, где все они будут принимать максимальное значение, 

— белый (рис. 4). 

 

Рис. 4. Цветовой куб модели RGB 

Главная диагональ такого куба, проходящая от черного (0, 0, 0) к белому (1, 1, 1) 

цвету, называется ахроматической осью или шкалой яркости. На ней лежат цвета с 

одинаковым количеством каждого компонента, поэтому они являются оттенками серого. 

Модель RGB называется аддитивной. При увеличении яркости отдельных 

составляющих увеличивается и яркость результирующего цвета. 

При смешении всех трех цветов с максимальной интенсивностью 

получается белый цвет (рис. 4), при отсутствии всех цветов – черный. 

Каждому цвету можно сопоставить код, который содержит значения яркости трех 

составляющих. Используются десятичное и шестнадцатеричное представления кода. 



 

Рис. 5. Комбинации базовых цветов модели RGB 

Десятичное представление — это тройка десятичных чисел, разделенных 

запятыми. Первое число соответствует яркости красной составляющей, второе — зеленой, 

а третье — синей. Код цвета в шестнадцатеричном представлении имеет вид 0хХХХХХХ. 

Префикс 0х указывает на шестнадцатеричное число. За префиксом следуют шесть 

шестнадцатеричных цифр (0, 1, 2,...,9, А, В, С, D, E, F). Первые две цифры — 

шестнадцатеричное число, представляющее яркость красной составляющей, вторая и 

третья пары соответствуют яркости зеленой и синей составляющих. 

Если все составляющие имеют максимальную яркость (255,255,255 — в 

десятичном представлении; 0xFFFFFF — в шестнадцатеричном представлении), то 

получается белый цвет. Минимальная яркость (0,0,0 или 0x000000) соответствует черному 

цвету. Смешение красного, зеленого и синего цветов с различными, но одинаковыми 

яркостями дает шкалу из 256 оттенков (градаций) серого цвета — от черного до белого. 

При наложении отдельных каналов результат получается не совсем такой, как если 

бы смешивались краски. Базовые цвета смешиваются следующим образом: 

     Красный и зеленый — при максимальной яркости дают желтый цвет. 

Уменьшение яркости красного изменяет результирующий цвет в сторону зеленоватого, а 

уменьшение яркости зеленого делает цвет оранжевым. 

     Зеленый и синий — при максимальной яркости дают голубой. Изменяя 

пропорцию яркостей можно получить 65 000 оттенков голубого, от небесного до темно-

синего. 

     Красный и синий — при максимальной яркости дают пурпурный или 

фиолетовый. Уменьшение яркости синего сдвигает цвет в сторону розового, а уменьшение 

красного — в сторону пурпурного. 



Так как яркость каждой из базовых составляющих цвета может принимать только 

256 целочисленных значений, каждое значение можно представить 8-разрядным 

двоичным числом (последовательностью из 8 нулей и единиц, 256 = 2
8
) или, 

одним байтом. Каждый разряд в байте называется битом (двоичной единицей или 

нулем). Таким образом, в модели RGB информация о каждом цвете требует 3 байта (по 

одному байту на каждый базовый цвет) или 24 бита памяти для хранения. Поскольку все 

оттенки серого цвета образуются смешением трех составляющих одинаковой яркости, то 

для представления любого из 256 оттенков серого требуется лишь 1 байт. 

Цветовая модель CMYK 

Рассмотренная выше модель RGB хорошо описывает цвета, получаемые в 

результате смешения лучей света различной окраски. Таким образом, она подходит для 

предсказания цветов, видимых на мониторе, а также получающихся при сканировании 

изображений, но не подходит для печатающих устройств. 

Смешение красок, которое делают печатающие устройства, описывает 

модель CMYK. На рисунке 6 показана комбинация базовых цветов CMYK. 

Базовые цвета CMYK называются субтрактивными и получаются путем 

вычитания из белого одного из базовых цветов модели RGB. 

Тогда базовые цвета модели CMYK можно представить с помощью формул 

вычитания базовых цветов модели RGB следующим образом: 

Cyan = RGB - R = GB = (0,255,255) 

Yellow = RGB - В = RG = (255,255,0) 

Magenta = RGB - G = RB = (255,0,255) 

Вычитание из белого цвета белого любое количество раз дает в результате –

 черный: 

RGB - RGB = RGB - RGB - ... - RGB = (0,0,0) 

А сложение белых цветов — белый: 

RGB + RGB = RGB + RGB + ... + RGB = (255,255,255) - белый цвет 

Сложение всех базовых цветов CMYK дает в результате черный. 

Cyan+Yellow+Magenta=RGB-R-B-G=(0,0,0) 



 

Рис. 6. Комбинации базовых цветов модели CMYK 

Вычитание из белого всех базовых цветов CMYK дает белый: 

RGB-(RGB-R)-(RGB-В)-(RGB-G)=RGB-RGB+R+В+G=RGB=(255,255,255) 

Вычитание цвета соответствует поглощению его краской. Например, голубая 

(Cyan) краска поглощает из падающего на нее белого света красную составляющую, а все 

остальное отражает. Этот отраженный свет наш глаз и воспринимает как голубой. Белый 

лист бумаги потому кажется нам белым, что он отражает практически весь падающий на 

него белый свет. С другой стороны, черные предметы почти ничего не отражают, а почти 

весь свет поглощают. Базовые цвета модели CMYK являются довольно яркими цветами и 

не вполне годятся для воспроизведения темных цветов. Так, при их смешивании на 

практике получается не чисто черный, а грязно-коричневый цвет. Поэтому в цветовую 

модель CMYK включен еще и чистый черный цвет, который используется для создания 

темных оттенков, а также для печати черных элементов изображения. 

Смешение цветов в модели CMYK противоположно смешению составляющих в 

модели RGB. Однако краски субтрактивной модели не являются столь чистыми, как цвета 

аддитивной модели. Этим и объясняются следующие особенности: 

     Голубой и пурпурный — при максимальной яркости дает глубокий синий цвет с 

небольшим фиолетовым оттенком. Уменьшение яркости голубого делает цвет пурпурным, 

а уменьшение яркости пурпурного — средне-синим (желтой краски нет совсем). 

     Пурпурный и желтый — при максимальной яркости смесь получается ярко-

красного цвета. Уменьшение яркости пурпурной составляющей приводит к оранжевому, а 

уменьшение яркости желтой — к розовому цвету (голубая составляющая отсутствует). 

     Желтый и голубой — ярко-зеленый цвет с небольшим оттенком синего. 

Уменьшение яркости желтого дает изумрудный цвет, а уменьшение яркости голубого — 

салатовый цвет (пурпурная составляющая отсутствует). 



Основные цвета рассмотренных выше моделей RGB и CMYK находятся в 

зависимости, которую можно графически представить с помощью рисунка 7. 

Каждый цвет расположен напротив дополняющего его и между цветами, с 

помощью которых он получен. Чтобы усилить какой-либо цвет, необходимо ослабить 

дополняющий цвет, расположенный на противоположной стороне круга. Например, 

чтобы усилить желтый (Yellow), надо ослабить синий (Blue). На круге цветов желтый 

расположен между зеленым (Green) и красным (Red). Сложение этих цветов цветов дает 

желтый (Yellow). 

 

Рис. 7. Взаимосвязь основных цветов RGB и СМУК 

Выводы: 

     Цвет — это как субъективная субстанция, суть которой в индивидуальном 

восприятии, так и объективная, поскольку физические причины, вызывающие ощущение 

цвета, существуют вне человека. 

     На этапе анализа цветовая информация с помощью фильтров преобразуется в 

яркостную (техническая система избавляется от цвета как такового). Полученная 

яркостная информация реализуется в виде цветовых каналов (на самом деле — серых) в 

пиксельных изображениях. 

     Визуализация цвета происходит на этапе синтеза, когда фиксированная 

яркостная картина используется как регулятор степени вклада каждой цветовой 

составляющей в общем цветном изображении. Синтез цвета осуществляется совсем 

другими средствами, например: свечением капель люминофора или отражением цветных 

пятен на бумаге, что делает принципиально невозможным абсолютно точное 

воспроизведение исходной цветовой информации. 

     Для превращения цвета в цифровую форму необходимо его математическое 

описание. Оно производится на основе нескольких моделей цвета. 



     Аддитивная модель цвета RGB описывает излучаемые цвета. Монитор и сканер 

используют эту модель для оцифровки цвета. Субтрактивная модель цвета CMY 

описывает отраженные цвета. Полиграфическая модель CMYK создана на основе CMY 

путем введения четвертого, черного канала. 

     Модели RGB и CMYK являются аппаратно-зависимыми, то есть цвет с 

одинаковым описанием будет визуально отличаться на устройствах с разными 

характеристиками. 

     Различные устройства имеют разный цветовой охват. Цветовой охват зависит от 

способа генерации или восприятия цвета устройством. 

     В процессе подготовки изображения используются устройства с различным 

цветовым охватом и работающие на основе разных цветовых моделей. Для достижения 

корректного воспроизведения цветов разработана система цветокоррекции CMS. 

     Система цветокоррекции состоит в определении профиля, то есть способа 

изображения цветов каждым из устройств. Эти профили интерпретируются ядром CMS. 

Процесс построения профилей называется калибровкой. 

Практическое задание 

Подготовьте сообщение об одной из цветовых моделей. 

Контрольные вопросы 

1. Опишите цветовую модель RGB 

2. Опишите цветовую модель CMYK 

 

Практикум №3 

 

Тема: «Изучение возможностей меню Adob Photoshop» 

Цель практикума: изучить возможности меню Adob Photoshop. 

1. Описание графического редактора Adobe Photoshop. 

Графический редактор Adobe Photoshop представляет собой профессиональную 

программу для редактирования компьютерной живописи и фото, создания и обработки 

полиграфических иллюстраций. 

Редактор Photoshop использует четыре цветовые модели - HSB, RGB, LAB и 

CMYK. 

2. Панель инструментов 

Панель инструментов (tools bar) является основной рабочей панелью Photoshop. 

Расположенные в ней инструменты делятся на основные и альтернативные (скрытые). 

Основные инструменты (рис. 1) видны в главном окне программы. Альтернативные 



инструменты спрятаны за теми иконками, у которых в правом нижнем углу есть 

маленький треугольник. Для выбора альтернативного инструмента нужно установить 

курсор на значок основного инструмента, нажать левую кнопку мыши и, удерживая её, 

перетащить курсор на значок нужного альтернативного инструмента. 

Рис. 4. Инструменты основной палитры 

Панель (палитра) параметров (Options) (рис. 5). Здесь отображаются все 

изменяемые настройки инструментов. Данная панель меняет вид в зависимости от 

выбранного инструмента. Далее в таблице 2 будут представлены основные инструменты 

графического редактора Photoshop. 

Рис. 5. Панель параметров для инструмента Marquee (Прямоугольная область) 

Таблица 2 

Инструменты выделения, перемещения и обрезки 

 

Данная группа представляет собой инструменты, которые осуществляют 

геометрическое выделение: 

Marquee - Прямоугольная область выделяет области прямоугольной формы. 

Elliptical marquee - Овальная область - выделяет области овальной формы 

. Single row marquee - Область (горизонтальная строка) - производит выделение 

горизонтальной полосы толщиной в 1 пиксел. 

Single column marquee - Область (вертикальная строка) производит выделение 

вертикальной полосы толщиной в 1 пиксел. 

 

Группа свободного выделения. 

Lasso - Лассо - выделяет всю обведенную область. 

Polygonal lasso - Многоугольное лассо - строит границу выделения мелкими шагами в виде 

прямых отрезков. 

Magnetic lasso - Магнитное лассо - строит выделение на основе цветовой разности. 

 

Magic wand - Волшебная палочка - выделяет область пикселов по их цветовой 

схожести. Основным параметром является Tolerance (Допуск), задает степень близости 

цвета пикселов, необходимую для добавления их в выделение. 

 

Crop - Рамка - обрезает изображение до указанной области. 



 

Slice - Фрагмент - применяется для разрезания изображения на куски и 

последующей оптимизации для использования в Интернете. 

Инструменты рисования и ретуширования 

 

Группа инструментов предназначена для ретуширования изображений. 

Healing Brush - Лечащая кисть - осуществляет текстурную коррекцию с учетом 

подложки. 

Patch Tool - Заплатка - сочетание произвольного выделения и заливки. 

 

Brush - Кисть - прямое рисование активным цветом. 

 

Группа инструментов предназначена для фотомонтажа. 

Clone Stamp - Штамп - незаменимый инструмент при фотомонтаже. Действует 

следующим образом: укажите мышью (с нажатой клавишей Alt), из какого места на 

изображении перерисовывать, затем просто водите кистью в том месте, где необходимо 

повторить выбранный фрагмент. 

Pattern Stamp - Фигурный штамп - позволяет рисовать текстурой. 

 

History Brush - Кисть состояния - позволяет рисовать из любого места истории. 

Art History Brush - Художественная восстанавливающая кисть - восстанавливает 

состояние изображения из снимка истории и позволяет применять различные 

художественные эффекты. 

 

Eraser - Ластик - позволяет удалять кусочки изображения. 

Background Eraser - Фоновый ластик - ластик, предназначенный для отделения объекта 

от фона. 

Magic Eraser - Волшебный ластик - выделяет область, а затем удаляет ее. 

Инструменты заливки 

 



Gradient - Градиент - создает заливку с плавным переходом между двумя или 

несколькими цветами. 

Paint Bucket - Заливка - заливает изображение цветом или текстурой. 

Инструменты коррекции изображения 

 

Blur - Размытие - инструмент для размытия участка изображения. 

Sharpen - Резкость - увеличивает контрастность области. 

Smudge - Палец - создает эффект, похожий на размазывание пальцем еще не высохшей 

краски на полотне. 

 

Dodge - Осветлитель - изменение яркости пикселов в сторону увеличения, что 

приводит к осветлению изображения. 

Burn - Затемнитель - изменение яркости пикселов в сторону уменьшения, что приводит к 

затемнению изображения. 

Sponge - Губка - изменяет насыщенность цвета в редактируемой области. 

Инструменты ввода текста, создания контуров и фигур 

 

Type - Текст - горизонтальный текст, цвет которого определяется цветом 

переднего плана (Foreground Color). 

Vertical Type Tool - текст в вертикальном направлении. 

Horizontal Type Mask Tool - писать выделением. 

Vertical Type Mask Tool - текст как выделение в вертикальном направлении 

 

Pen - Перо - инструмент, который создает контуры. 

Freeform Pen - Свободное Перо - инструмент, ближайшим аналогом которого является 

Lasso (Лассо), однако данный инструмент создает контур, а не выделение. 

Add Anchor Point - Перо+ - добавить опорную точку контура. 

Delete Anchor Point - Перо- - удалить опорную точку. 

Convert Point - Угол - инструмент для модификации контура. 

 

Данная группа позволяет быстро и легко создавать двухмерные геометрические 

фигуры. 



Rectangle - Прямоугольник 

Rounded Rectangle - Скругленный прямоугольник 

Ellipse - Эллипс 

Polygon - Многоугольник 

Line - Линия 

Custom Shape - Пользовательская фигура. В данном списке содержатся фигуры, 

созданные вручную. При помощи команды Edit -> Define Custom Shape (Редактирование > 

Определить новую фигуру) пользователь может сохранить любой контур как фигуру и 

использовать ее в дальнейшем. 

 

Path Selection - Перемещение фигур - применяется для перемещения фигур. 

Direct Selection - Модификация фигур - инструмент, при помощи которого можно менять 

вид фигуры путем воздействия на точки и линии контура, ограничивающего фигуру. 

Инструменты для вставки пометок 

 

Notes - Пометка - инструмент, предназначенный для создания текстовых пометок 

в работах. 

Audio Annotation - Аудиозапись - инструмент, предназначенный для создания звуковых 

пометок в работах. 

Измерительные инструменты 

 

Eyedropper - Пипетка - позволяет сделать цветом переднего плана (Foreground 

Color) цвет того пиксела, по которому пользрватель щелкает этим инструментом в данный 

момент. 

Color Sampler - Выбор цветов - позволяет делать активными не один, а несколько цветов. 

Measure - Линейка - используется для измерения расстояний и углов. 

Инструменты управления просмотром 

 

Hand - Рука - позволяет двигать изображение в пределах экрана. 

 

Zoom - Масштаб - масштабирование изображения. 

Инструменты выбора цветов и режима 



 

1. Set Foreground Color - Установить цвет переднего плана. 

2. Set Background Color - Установить цвет заднего плана. 

3. Default Foreground and Background Colors - Установить цвет по умолчанию. 

4. Switch Foreground and Background Color - Поменять местами цвета переднего и 

заднего плана. 

 

Edit in Standard Mode - Работать в обычном режиме - все инструменты работают 

так, как и должны работать по своему назначению. 

 

Edit in Quick Mask Mode - Редактировать быструю маску. Быстрая маска 

существует для однократного применения и не сохраняется на протяжении всей работы. 

Контрольный вопрос: с какими инструментами вы познакомились? 

 

Практикум №4 

 

Тема: «Изучение возможностей меню Adobe Photoshop» 

Цель: 

1. Программа Adobe Photoshop может быть запущена при помощи меню 

Пуск в нижнем левом углу экрана. После нажатия кнопки Пуск 

выбираем пункт Все программы и отыскиваем в списке 

программ Adobe 

Photoshop. Запустите 

Photoshop. 

1.1. После загрузки откроется окно программы. Сверху расположена 

строка главного меню с раскрывающимися пунктами Файл, Редактирование, … и 

т. д. 

Нажимайте на эти пункты, раскрывая выпадающие меню. Когда 

изображение не загружено, большинство команд меню недоступны (серого 

цвета), некоторые доступны (черные). 

1.2. Слева Панель инструментов, на которой располагаются основные инструменты 

работы с изображением и цветом. Попробуйте ухватить левой кнопкой мыши за синий 

верх Панели и поперемещайте ее по окну программы. 



1.3. На панели находятся иконки инструментов. Инструмент становится активным 

и подсвечивается при нажатии левой кнопкой мыши. При наведении мыши на 

инструменты возникают всплывающие подсказки с их названиями. 

1.4. Некоторые значки инструментов в нижнем правом углу 

содержат маленький черный треугольник. Нажмите на один из таких 

инструментов ПРАВОЙ кнопкой мыши. Раскроется группа инструментов. В группе вы 

можете выбрать левой кнопкой другой инструмент, и тогда значок инструмента на панели 

сменится на выбранный вами. 

1.5. Под инструментами располагаются 2 квадратика – поле выбора переднего 

цвета/фона. Стрелка в углу рядом с ними меняет их местами. 

1.6. У разных 

инструментов – разные свойства 

и настройки. Свойства и настройки инструментов отображаются в строке, которая 

находится вверху программы, под строкой главного меню. Выбирайте разные 

инструменты и наблюдайте смену набора свойств и настроек в этой области. Например, 

при смене инструмента с Лассо на Кисть в 

этой строке свойства (1) меняются на (2): 

 

Здесь вы можете установить нужные вам свойства – 

вводить цифры, ставить галочки, выбирать режимы из списков и 

т.д. 

1.7. 

Палитры 

(справа) 

занимают около ¼ всей площади 

экрана и содержат различные инструменты настроек 

изображения. 

Окна палитр также можно перетаскивать за 

синюю область сверху. 

Сейчас, когда изображения нет, многие из 

палитр пустые и неактивные. 

1.8. В верхнем правом углу окна каждой палитры есть кнопки сворачивания и 

закрытия окна. Нажмите кнопку сворачивания  на разных палитрах по нескольку раз. 

Верните палитры в исходный вид. Кнопка закрытия убирает палитру с экрана . 

Закройте какую-нибудь из палитр нажатием этой кнопки. 



1.9. Настроек на палитрах так много, что они тоже объединены в группы. Разные 

настройки групп вызываются нажатием на закладки в верхней части палитры. Активная 

закладка заслоняет остальные, например  меняется на . 

Понажимайте разные закладки на палитрах. 

1.10. Можно создавать свои группы палитр. Ухватите мышью какую-нибудь 

закладку левой кнопкой мыши за текст на закладке и держа кнопку мыши потяните 

немного в сторону. От палитры отделится серый контур. Если отпустить его на пустом 

месте экрана программы – палитра отделится. А если навести верхний левый угол серого 

контура на другую палитру (в любое место, кроме синей полосы сверху) и 

отпустить ее там – они объединятся в новую группу. 

1

.11. Маленькие 

палитры не могут 

вместить огромное количество настроек, доступное в Photoshop. Эти настройки 

открываются при нажатии на белый круг с черным треугольником внутри (под кнопкой 

закрытия) 

Если активировать 

другую закладку, 

треугольник покажет 

набор настроек для этой закладки палитры. 

1.12. Если вы считаете, что нестандартные настройки палитр и инструментов – 

удачные, их можно сохранить. Или наоборот, вы можете захотеть сбросить изменения. 

Нажмите в главном меню пункт Окно, в раскрывшемся списке выберите Проект. Здесь 

можно Сохранить рабочее пространство или – Сбросить расположение палитр. Выберите 

пункт - Сбросить… 

Задания: 

1) переместите Панель инструментов в правую часть окна Photoshop, а все окна 

палитр – в левую (см. пункты 1.2. и 1.7.); 

2) на Панели инструментов по очереди раскройте все группы инструментов и 

выберите в каждой из них нижний инструмент (см. пункт 1.4.); 

3) при помощи всплывающей подсказки найдите инструмент Перемещение и 

установите в его свойствах галочки в пунктах Автоматический выбор слоя и Показать 

ограничивающий прямоугольник (см. пункты 1.3. и 1.6.); 



4) создайте новую группу палитр из закладок Навигатор, Цвет, История (см. пункт 

1.10.); 

5) выберите в этой группе закладку Цвет, раскройте ее настройки (см. пункт 1.11) и 

уберите галочку с пункта Регуляторы RGB, поставив ее на Черно-белый. 

Обратите внимание, что параметр Разрешение в этом меню вовсе не означает 

привычное нам разрешение (ширину и высоту цифрового изображения.) 

а) дать изображению имя 

б) установить размеры… 

в) в удобных вам единицах 

г) выбрать цветовой режим 

д) задать содержимое фона 

6) сверните все палитры, кроме группы палитр Навигатор, Цвет, История (см. 

пункт 1.8.); 

7) сохраните созданное Рабочее пространство, назвав его своей Фамилией (см. 

пункт 1.12) 

2. Создание нового изображения. В главном меню выберите пункт Файл → Новый. 

Появляется окно настройки нового изображения. Найдите на нем и запомните места, в 

которых можно: 

Запомните – параметр Разрешение и 

глубину цвета (8 бит) в этом меню изменять не 

нужно. 

2.1. Один за другим создайте 3 новых 

файла с указанными параметрами: 

№ 

Имя (а) 

Ширина/Высота (б) 

Единицы измерения (в) 

Цветовой режим (г) 

Содержимое фона (д) 

1. 

file 1 

355*355 

пиксели 

RGB 

Цвет фона 



2. 

file 2 

1024*768 

пиксели 

LAB 

Белый 

3. 

файл 3 

640*480 

пиксели 

Черно-Белый 

Прозрачный 

2.2. Созданные вами файлы расположились в разных 

местах окна программы, частично закрывая друг друга. Если 

файлов много, можно быстро разместить их при помощи команды главного меню Окно → 

Упорядочить → 

Мозаика. Окна 

будут расставлены автоматически. 

2.3. Итак, файлы созданы, и теперь 

ранее неактивная палитра Навигатор может управлять окнами, 

позволяя менять масштаб просмотра. Сделайте активным окно файла file 1, щелкнув 

мышью на его синем заголовке. Передвигая ползунок масштаба, установите масштаб 

около 10% - при этом лист будет виден весь, и займет лишь небольшую часть своего окна. 

Для файла 3 установите масштаб около 150%. При этом лист не поместится целиком в 

окне, и Навигатор отобразит видимую в нем часть в виде красной рамки. Схватите эту 

рамку мышью и сдвиньте в нижний правый угол. 

2.4. Окно каждого из этих файлов содержат стандартные кнопки свертывания, 

разворачивания и закрытия в верхнем правом углу . Нажмите кнопку 

свертывания  окна файла 03. 

Обратите внимание – файл сворачивается на 

панель задач, в нижний левый угол 

программы Photoshop. Теперь нажмите кнопку закрытия  окна file 02.Наконец, в 

окне file 01 нажмите кнопку разворачивания . Окно file 01 развернется на всю 

программу. Теперь кнопки управления окном file 01 переместились в верхний правый 



угол программы Photoshop , став при этом серого цвета. Нажмите на левую из 3-х 

серых кнопок -  - свертывание. Теперь оба окна – файл 03 и file 01 – находятся в 

свернутом виде в нижнем левом углу программы (см. рис. справа). Оставьте file 01 

свернутым, а файл 03 разверните на весь экран, нажав кнопку . 

2.  

5. Предъявите преподавателю результат ваших действий с файлами и 

интерфейсом программы. 

3. Сформулируйте цель практикума 

Практикум №5 

 

Тема: Изучение панели инструментов и цветовой палитры Adob Photoshop. 

Цель: 

Пользователи Adobe Photoshop – фотографы, ретушеры, художники по рекламе, 

иллюстраторы, дизайнеры. Обычно они работают с такими изображениями, как 

фотографии, книжные и журнальные иллюстрации, а также эскизы черно-белых рисунков. 

Интерфейс пользователя включает заголовок программы, главное командное меню, 

рабочие окна для отображения документов, а также совокупность различных палитр, при 

помощи которых осуществляется редактирование изображений. 

Самая верхняя полоса темно-синего цвета называется строкой заголовка, она 

отображает название и пиктограмму программы, и содержит три кнопки, которые 

позволяют управлять размерами и местоположением программного окна. 

Под полосой заголовка расположена полоса главного командного меню, которая 

предлагает следующие группы команд: Файл, Редактирование, Изображение, Слой, 

Выделение, Фильтр, Анализ, Просмотр, Помощь. 

Каждая группа – это совокупность команд, выполняющих функционально близкие 

действия. 

Программа Adobe Photoshop позволяет настроить списки команд, доступных в 

выпадающих меню. 

У каждого инструмента есть свои параметры. Они отображаются на панели свойств 

Параметры, которая находится под строкой меню. 

Панель инструментов, по умолчанию, всегда выводится на экран при запуске 

программы, но может быть удалена с экрана командой Инструменты меню Окно. 

Выбор любого инструмента осуществляется простым щелчком на его кнопке. Если 

на этой кнопке имеется треугольная стрелка, это значит, что кнопка скрывает несколько 



инструментов. Для того чтобы включить один из них, необходимо нажать кнопку, 

дождаться появления кнопок всех инструментов и, не отпуская кнопки мыши, протянуть 

указатель до нужного инструмента, и только тогда отпустить кнопку мыши. 

Рассмотрим некоторые инструменты панели. 

Для выделения фрагментов изображения в виде прямоугольников или овалов 

используются инструменты Rectangular Marquee (Прямоугольная область), Elliptical 

Marquee (Овальная область). 

Инструмент Lasso (Лассо) позволяет выделять области произвольной формы, рисуя 

контур выделения курсором мыши. 

Инструмент Polygon Lasso (Многоугольное лассо) используется для выделения 

многоугольников. 

Инструмент Magnetic Lasso (Магнитное лассо) очень удобен для выделения 

областей неправильной формы с четкими контурами. 

Инструмент Magic Wand (Волшебная палочка) выделяет области, состоящие из 

близких по цвету пикселей. 

 

Выполнение практических заданий 

Задание 1. 

1. Запустите программу Adobe Photoshop. (Пуск → Программы → Adobe 

Photoshop). 

2. Установите основной цвет – зеленый, фоновый – голубой. 

3. Создайте новый документ размером 300 х 200 пикселей, установив Режим 

(Mode) = RGB; Разрешение (Resolution) = 72 pix/cm; Содержание (Contens) = Цвет фона 

(Backgraund). 

4. Нарисуйте дерево и солнце, установив размер и параметры карандаша. 

5. Нарисуйте радугу, установив размер и параметры кисти. 

6. Сохраните в своей папке под именем raduga. 

7. Открыть документ dog.jpg из папки Allshoto. 

8. Используя инструменты Кисть, Заливка, Палец закрасить фрагменты рисунка. 

Добавить к иллюстрации фон, используя инструмент Градиент для окраски неба и земли. 

9. Сохраните в своей папке под именем dog_color.jpg. 

 

СПРАВКА: 

 

• Для создания нового документа: Файл/Новый (File/New) 



• Для изменения основного (фонового) цвета нужно щелкнуть по кнопке Основной 

(Фоновый) цвет и выбрать новый. 

• Для выполнения задания 8 рекомендуется вынести объекты (собака, миска, 

облака) в отдельный слой dog. 

 

Контрольные вопросы: 

1. Сформулируйте цель практикума 

2. Какой стандартный вид окна Adobe Photoshop? 

3. С какими инструментами вы познакомились? 

 

Практикум №6 

 

Тема: «Создание декоративного текста» 

Цель: 

Выполнение практических заданий 

Задание 1. 

1. Запустите программу Adobe Photoshop. (Пуск → Программы → Adobe 

Photoshop). 

2. Установите основной цвет – зеленый, фоновый – голубой. 

3. Создайте новый документ размером 300 х 200 пикселей, установив Режим 

(Mode) = RGB; Разрешение (Resolution) = 72 pix/cm; Содержание (Contens) = Цвет фона 

(Backgraund). 

4. Открыть документ dog.jpg из папки Allshoto. 

5. Добавьте к изображению текст (имя щенка), расположенный в отдельном слое. 

6. Преобразуйте текстовый слой в обычный. Закрасить текст инструментом 

градиент. 

7. Примените к слою эффект объема. Создайте тень. 

8. Сохраните документ под тем же именем. 

9. Создайте новый документ размером 500 х 400 пикселей, установив Режим 

(Mode) = RGB; Разрешение (Resolution) = 72 pix/cm; Содержание (Contens) = Белый 

(White). 

10. Напишите слово SHADOW и создайте перспективную тень. 

11. Сохраните документ в своей папке под именем shadow.gif. 



12. Создайте новый документ размером 700 х 300 пикселей, установив Режим 

(Mode) = RGB; Разрешение (Resolution) = 72 pix/cm; Содержание (Contens) = Белый 

(White). 

13. Напишите слово HAPPY BIRTHDAY TO YOU и создайте рельефный текст, 

размещенный по траектории. 

14. Применить к слою Backgraund фильтр Облака, установив основной цвет – 

голубой. 

15. Для «ощущения» льда применить к слою Backgraund фильтр Океанская рябь, 

подобрав соответствующие параметры 

16. Сохраните документ в своей папке под именем happy.gif. 

 

СПРАВКА: 

 

• Для создания нового документа: Файл/Новый (File/New) 

• Для преобразования текстового слоя в обычный: 

- щелкните правой кнопкой по синему полю слоя в панели Слои. 

- выберите команду Растеризация слоя 

- буква Т на изображении слоя панели Слои исчезла 

• Для создания эффекта объема и тени выполните команду Слой \ Эффекты слоя \ 

Рельеф… (Тень..) (Layers \ Effects \ Bevel and Emboss….). 

• Для создания перспективной тени : 

-преобразуйте текстовый слой в обычный 

- создайте копию и разместите её ниже исходного слова 

- выполните команду Редактирование \ Преобразование \ Повернуть по вертикали 

- примените линейную градиентную заливку (для выделения можно сначала 

Волшебной палочкой щелкнуть вне слова, а затем выполнить команду Выделение \ 

Инвертировать выделение) 

- выполните команду Фильтр \ Смазывание \ Смазывание Гаусса.., настроив 

значение в поле Радиус 1,2 

- выполните команду Редактирование \Трансформация \ Перспектива 

• Для создания рельефного текста, размещенного по траектории: 

- преобразовать текстовый слой в обычный 

- выполнить команду Фильтр \Distitr \Sheare (Фильтр \Деформация \Искривление) и 

изменить форму траектории 



 против часовой стрелке-выполнить команду Редактирование \Трансформация\ 

Поворот на 90  

- применить к тексту фильтр Фильтр \Sketch \Bas Relief… 

• Для установления фильтра Облака примените команду Фильтр \Render \Clouds 

(Фильтр \Освещение \Облака) 

• Для установления фильтра Океанская рябь примените команду Фильтр \Distort 

\Okean Ripple (Фильтр \Искажение \Океанская рябь) 

 

Задание 2. Перекрывающийся текст 

 

Перекрывающийся текст часто используется при оформлении, например, 

поздравительных открыток. 

1. Создаем новый документ с белым фоном. 

Используя инструмент Horizon Туре (Горизонтальный текст), вводим наш первый 

текст. Лучше, чтобы он состоял из нескольких слов. Стиль шрифта выберите по своему 

усмотрению — здесь это не имеет особого значения. Чуть ниже аналогично введите 

следующий текст. Именно эти два текста мы и будем пересекать. Для большей 

эффективности советуем эти тексты писать разными цветами. Можно немного украсить 

тексты, но это следует делать именно на начальном этапе. Мы добавим немного тени и 

объемности обоим текстам, используя меню 

. Layer ► Layer Style ► Drop Shadow (Слой ► Эффекты слоя ► Тень). 

2.  

 

Для того чтобы два текста пересекались, необходимо изменить направляющие, по 



которым они написаны. Для этого на панели параметров инструмента Horizontal Туре 

(Горизонтальный текст) щелкаем на кнопке Create Warped Text (Создает 

деформированный текст). В диалоговом окне Warp Text (Деформировать 

текст) первым делом в раскрывающемся списке Style (Стиль) выбираем стиль искажения 

текста. Мы выбрали для нашего примера стиль Flag (Флагом). Ниже настраиваем 

параметры искажения. Все эти параметры, как и стиль искажения, выбирайте на свое 

усмотрение. Режим предварительного просмотра результатов дает возможность найти 

довольно интересные эффекты. 
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3. Аналогичные действия производим и со вторым текстом, только параметры 

искажении лучше устанавливать противоположными. 

4. Когда оба текста искажены по нашему желанию, с помощью 

соответствующих инструментов перемещаем тексты так, чтобы создалось их видимое 

пересечение. 

5. Далее нам потребуется создать копии слоев, содержащих тексты. В 

результате у нас должно получиться пять слоев: два исходных текстовых, два 

текстовых копированных и один фоновый. Пересортируем их таким образом, чтобы 

самым нижним на палитре Layers (Слои) оставался фоновый 

слой Background (Задний план), над ним располагался слой с первым текстом, выше — 

слой со вторым текстом, над которым его же копия. Выше всех должна находиться копия 

слоя с первым текстом. После такого перемещения изменится и взаимное пересечение 

наших текстов в документе. Первый текст должен быть полностью виден и написан 

поверх второго. На инструментальной панели выбираем 

инструмент Rectangular Marquee (Прямоугольная область) и выделяем фрагмент 

изображения в самом верхнем слое. Причем выделять следует только ту часть текста, 

которая должна оказаться сверху. В нашем примере это была правая часть изображения. 



6. Выполняем команду 

меню Layer ► Add Layer Mask ► Reveal Selection (Слой ► Добавить слой-маску ► 

Показать все). 

7. Вот и все! (Результат покажите педагогу) 

 

Контрольные вопросы: 

1. Сформулируйте цель практикума 

2. Какой стандартный вид окна Adobe Photoshop? 

3. С какими инструментами вы познакомились? 

 

Практикум №7 

 

Тема: «Создание изображений в технике свободного рисования» 

Цель: 

Основные инструменты для рисования в Фотошопе 

Кисть (Brush) – основной инструмент, которым вы будете пользоваться. С его 

помощью вы сможете создавать самые разные линии. Как рисовать в Фотошопе с 

помощью кисти? Достаточно выбрать инструмент на панели и провести ним нужную 

линию. Казалось бы, все просто, но дело усложняется тем, что у инструмента есть 

множество настроек. Если вы заглянете в них, вы увидите, что кисти могут быть разной 

формы, разного размера, жесткости и пр. 

Ластик (Eraser) поможет вам удалить с рисунка неудавшиеся детали. Он также 

может иметь разную форму, размер и жесткость. Принцип его работы отличается от кисти 

только тем, что он стирает. Важно помнить о том, что стирать он будет фоновым цветом, 

каким бы он не был. 

Заливка (Paint Bucket) поможет вам залить определенный участок изображения 

желаемым цветом. 

Градиент (Gradient) – инструмент для заливки, позволяющий создать плавный 

переход между цветами. Градиенты могут иметь разную форму и быть направленными в 

разные стороны. 

Как нарисовать прямую линию в Фотошопе? 

Рисование в своей основе сводится к рисованию линий. Конечно, позже с помощью 

различных инструментов их приводят к нужному виду, но все же рисовать линии 

необходимо. 



Для создания прямых линий в этой программе есть инструмент, так и названный 

– «Линия». Выбрать его можно, нажав на значок на панели инструментов либо горячую 

клавишу «U». Далее вы можете выбрать размер, толщину и пр. Чтобы нарисовать линию, 

проведите мышкой с зажатой левой клавишей. 

Еще один способ создать прямую линию – воспользоваться инструментом «Кисть». 

Выберите нужную вам кисть и поставьте ею точку в любом месте рисунка. После этого 

зажмите «Shift» и поставьте вторую точку. Вы увидите, что поставленные вами точки 

автоматически соединятся отрезком. 

Как нарисовать кривую линию? 

Самый простой способ нарисовать кривую линию в Фотошопе – провести ее от 

руки «Кистью» либо «Карандашом». Если такой вариант вам кажется слишком простым, 

вы можете нарисовать прямую линию, а затем искривить ее с помощью инструментов 

Photoshop. Делается это довольно просто и не требует каких-то навыков. Пробуйте! 

Практическое задание: нарисовать рисунок на свободную тему 

Результат показать педагогу 

Сформулируйте цель практикума 

 

 

Практикум №8 

 

Тема: «Простейшие приемы работы» 

 

Цель: 

Задание 1. Автомобиль в движении 

Шаг 1. Сначала откройте изображение с автомобилем. 

Желательно, чтобы в ней автомобиль располагался чётко 

горизонтально — тогда эффект получится более качественным. 

 

 

 

Шаг 2. Если изображение с автомобилем является 

фоновым слоем, то нужно преобразовать этот слой в обычный. 

Для этого выберите опцию Layer\New\Layer from Background 

(Слой\Создать\Слой из фона). Присвойте этому слою имя “bg”. 

Теперь нужно выделить сам автомобиль. Сделать это можно 



при помощи инструмента Polygonal Lasso (Прямоугольное лассо). 

Шаг 3. Теперь нажмите [Shift+Ctrl+J], чтобы вырезать 

из изображения сам автомобиль. После этого сделайте 

активным нижний слой “bg”. Теперь размоем фоновый слой. 

Для этого выберите опцию Filter\Blur\Motion Blur 

(Фильтр\Размытие\В движении). Параметру Angle (Угол) 

присвойте значение 0, а параметру Distance (Дистанция) — 

100. Вообще, это значение может быть любым — всё зависит от вашего вкуса. 

Шаг 4. Вы наверное заметили, что у нас видны 

прозрачные области. Но эти области прозрачны не на 100%, 

а потому создайте несколько копий фонового слоя. Проще 

всего это сделать так: перетащите слой на иконку листа 

бумаги в нижней части палитры Layers (Слои). Эту 

операцию надо повторять до тех пор, пока не исчезнут 

просветы. Мне пришлось создать 13 копий. В результате 

картина слоёв должна быть такой, как на рисунке слева. 

Шаг 5. Сейчас нужно склеить все фоновые слои, 

чтобы они не мешались. Скройте слой с самим автомобилем 

и выберите команду Layer\Merge Visible (Слой\Склеить 

видимые). Теперь можно снова сделать видимым слой с 

автомобилем. Сейчас изображение должно выглядеть так, 

как на рисунке слева. Однако нам нужно добавить 

реалистичности. Обычно при движении автомобиля у него крутятся колёса (правда 

гениальные вещи я говорю!), а, значит, это должно быть 

отражено на изображении. 

Шаг 6. Сделайте сначала активным слой с 

автомобилем. При помощи инструмента Elliptical Marquee 

(Эллиптическое выделение) выделяем диск заднего колеса 

автомобиля (это можно сделать и любым другим 

инструментом выделения). Теперь выберите команду 

Filter\Blur\Radial Blur (Фильтр\Размытие\Радиальное размытие). В появившемся окне для 

Amount (Количество) введите значение 40, а для Blur Method (Метод размытия) выберите 

Spin (Кручение). Теперь нажмите [Ctrl+D], чтобы снять выделение. То же самое 

проделайте и для переднего колеса. 



Шаг 7. Однако, вы можете заметить, что в кабине 

движущегося автомобиля нет водителя, поэтому надо 

затемнить стёкла. Вы можете сказать, что для автомобиля 

с открытым верхом не делают тонированных стёкол, но я 

просто не нашёл другой, более подходящей фотографии. 

Вы же можете выбрать любую другую. При помощи 

инструмента Polygonal Lasso (Прямоугольное лассо) выделите стекло. Затем нажмите 

[Ctrl+U], а в появившемся окне для параметра Lightness (Яркость) введите значение -70. 

Теперь нажмите [Ctrl+D], чтобы снять выделение. Всё, эффект готов! 

 

Задание 2. Падающая тень 

 

Шаг 1. Откройте изображение Tigr.jpg, к которому будете применять эффект. 

Теперь нужно выделить изображение тигра при помощи любых инструментов выделения 

(можно использовать инструмент Magic Wand (Волшебная палочка) с допуском 30). 

Скопируйте его на новый слой — нажмите для этого [Ctrl+J]. 

 



Шаг 2. Теперь щёлкните по только что созданному слою с нажатой клавишей 

[Ctrl], чтобы загрузить выделение тигра. Выберите команду Select\Transform Selection 

(Выделение\Трансформировать выделение, чтобы исказить выделение, и щёлкните 

правой кнопкой мыши по нему. Из списка выберите Distort (Искажение) и перетащите 

верхний средний маркер так, как на рисунке. Теперь нажмите [Enter]. 

 

Шаг 3. А сейчас с нажатой клавишей [Ctrl] щёлкните по листку бумаги в палитре 

слоёв, чтобы создать новый слой для тени под изображением тигра. Нажмите клавишу 

[D], чтобы сделать чёрный основным цветом. Выберите инструмент градиент [G] и 

залейте выделение от чёрного к прозрачному снизу вверх. Теперь нажмите [Ctrl+D], 

чтобы снять выделение. 

 

Шаг 4. Выделите верхнюю четверть тени инструментом Rectangular Marquee [M] 

(Прямоугольное выделение) и примените к ней команду Filter\Blur\Gaussian Blur 

(Фильтр\Размытие\Гауссово размытие) со значением 4. Теперь снимите выделение 

[Ctrl+D]. 

 

Шаг 5. Сейчас нужно выделить верхнюю половину тени тигра и нажмать [Ctrl+F], 

чтобы повторить действие фильтра. Далее проделайте эту операцию для верхних 3\4 

частей тени, а затем и для всей тени целиком. В результате вы должны получить такую 

тень, как видите слева. 



 

Шаг 6, финальный. Сейчас осталось только сделать видимым слой с тигром и 

передвинуть тень инструментом Move (Перемещение) так, чтобы она начиналась у 

основания лап. Всё, падающая тень готова! 

Сформулируйте цель практикума 

 

 

Практикум №9 

 

Тема: «Создание коллажа» 

Цель: 

Теоретическая часть 

Области правильной формы 

В PHOTOSHOP используют выделение областей различными способами – вручную 

или по цвету. Выделенный фрагмент изображения можно скопировать в буфер обмена, 

перенести на другое место, выполнить его заливку или рисовать в нем. Для выделения 

могут использоваться инструменты выделения на Панели инструментов и команды 

меню Выделение. 

 

 

 

Для выделения области правильной формы используются инструменты 

группы Выделение областей. 



 

Чтобы выделить область правильной Формы надо включить соответствующий 

инструмент, установить его в левый верхний угол будущей области выделения и 

перетащить вниз по диагонали до достижения требуемого размера. 

На панели управления инструментов выделения находится раскрывающийся 

список Стиль, устанавливающий дополнительные параметры: 

 Нормальный - ручное выделение; 

 Заданные пропорции - задается соотношение сторон 

прямоугольника или осей эллипса; 

 Заданный размер - задаются точные размеры. 

Для отмены выделения достаточно щелкнуть мышью вне области, выполнить 

команду Выделение/Отменить выделение или использовать клавиши CTRL+D 

Области произвольной формы 

Для создания выделений произвольной формы в PHOTOSHOP используют 

инструменты группы Лассо. 

 

При использовании инструмента Лассо необходимо, не отпуская клавишу мыши, 

обвести границу области и замкнуть ее. 

Инструмент Прямолинейное лассо позволяет построить контур выделения из 

прямых отрезков щелчками - от точки к точке, причем первая и последняя точка 

выделения должны совпасть. 

Для выделения контрастных областей удобно использовать 

инструмент Магнитное лассо. При обведении области этим инструментом программа 

сама находит наиболее контрастные точки и строит контур. 

Панели управления этих инструментов содержат основные настройки. 



 

. Инструмент «Волшебная палочка» 

 

 

 

Когда этот инструмент задействован в какой либо точке, он проверяет окружающие 

пиксели
1
 (попадают ли они в заданный интервал цвета) и на основании этого производит 

выделение. 

Панель управления этого инструмента позволяет настроить параметры выделения. 

 

Если при работе с инструментом удерживать клавишу SHIFT, то к выделенной 

области будут добавляться новые участки, близкие по цвету к точке применения 

инструмента. 

Перемещение, дублирование и удаление областей 

Для перемещения выделенных областей в PHOTOSHOP используют 

инструмент Перемещение. 

 



При включенном инструменте Перемещение выделенную область можно 

перемещать с помощью клавиш управления курсором ← →. При каждом нажатии 

клавиши область перемещается на один пиксель. 

При перемещении области изображение, находящееся в ней, 

сдвигается, а освободившееся место заполняется фоном. Если при 

перемещении области удерживать нажатой клавишу ALT, то изображение 

дублируется - перемещается копия выделенной области, а исходное 

изображение сохраняется. Можно перемещать выделенную область при 

помощи мыши, при этом вид курсора зависит от выполняемых действий. Вид курсора: 

курсор находится вне области; перемещение области; 

перемещение копии области; 

повторное перемещение области. 

 

Для удаления выделений можно нажать на клавиши DELETE или BACKSPACE, 

либо выполнить команду Редактирование/Очистить 

Трансформация областей 

Выделенные области можно подвергать трансформации. 

Д 

ля выполнения операций трансформации областей используются 

команды Редактирование/ Трансформирование или Редактирование/Свободное 

трансформирование. Трансформация выполняется командами меню, введением 

числовых значений на панели управления либо перемещением маркеров габаритной 

рамки. 

Для свободного изменения области необходимо при перемещении маркеров 

удерживать нажатой клавишу CTRL. Нажатие клавиши SHIFT при масштабировании 

сохраняет пропорции, а при вращении обеспечивает шаг в 15°. Завершение операции 

трансформации выполняется нажатием клавиши ENTER или щелчком по галочке на 



панели управления. Для отказа от трансформации необходимо нажать клавишу ESC или 

щелкнуть по кнопке  на панели управления. 

Практическое задание создание коллажа «Весь мир» 

1. Выбор изображений для коллажа. 

Прежде чем приступить к созданию коллажа, необходимо продумать какое 

изображение будет фоном, что будет на переднем плане, взаимосвязь изображений, 

единую структуру изображения. 

2. Оформление фона (задний план). 

Фоном может быть любое изображение, взятое из архива, а также фон можно 

создать самим, используя инструменты «Заливка» или «Градиент». 

В нашем случае, фоном будет градиентная заливка холста голубого и белого цвета. 

Ход работы: 

1. Открываем программу Adobe Photohop; 

2. Создаем новый файл (Файл – Новый); 

3. Размер и название вносим произвольно, фон выбираем белый, цветовой 

режим RGB; 

4. Открываем палитру основного цвета (щелчком по верхнему квадрату на 

панели инструментов), выбираем голубой цвет ; 

5. Открываем палитру фонового цвета (щелчком по нижнему квадрату на 

панели инструментов), выбираем белый; 

6. На панели инструментов выбираем инструмент 

«Градиент» , на панели управления устанавливаем 

настройку «Линейный градиент» ; 

7. На холсте рисуем вектор расположения 

градиента по диагонали от верхнего левого угла к нижнему 

правому; 

8. Фон изображения готов. 

 

3. Вставка фрагментов изображения на готовый фон: 

Наш коллаж состоит из фона и 4 вставленных фрагментов изображений из других 

файлов (котенок, Сатурн, бабочка, закат солнца). Для того чтобы вставить фрагмент из 



другого изображения, его необходимо выделить, подобрав удобный способ выделения, 

скопировать в буфер обмена и переместить на наше фоновое изображение. При 

необходимости изменить размер, развернуть, придать объем. 

Ход работы: 

1. Открываем в программе файлы с изображениями (Файл – Открыть ), 

указываем место расположения файлов с изображениями. 

2. Делаем активным первое изображение с Сатурном, используя инструмент 

«Выделение областей» (см. теоретическую часть), выбираем овальную область и 

выделяем планету. Копируем её в буфер обмена (Редактирование – Скопировать). 

3. Делаем активным фоновое изображение (голубой фон), вставляем 

изображение из буфера обмена (Редактирование – Вклеить). 

4. Фрагмент вставиться больше чем вы этого ожидали, поэтому его 

необходимо изменить (протрансформировать). Для этого выполняем команду 

Редактирование –Трансформирование – Масштабирование (см. теоретическую 

часть) Изменяем размер и перемещаем в правый нижний угол инструментом 

«Перемещение» (см теоретическую часть). 

5. Аналогично выполняем работу с другими изображениями (выделение, 

копирование, перемещение, трансформация), только для выделения котенка используем 

инструмент «Прямоугольная область» (см. теоретическая часть), чтобы удалить лишнее 

используйте инструмент «Ластик»; для выделения бабочки используйте инструмент 

«Магнитное лассо» (см. теоретическая часть), 

для выделения солнца используйте инструмент 

«Волшебная палочка» (см. теоретическая 

часть). 

6. Для придания объема планете 

Сатурн и Солнцу, на «палитре слои», в 

соответствующем слое применяем стили 

наложения по вашему 



желанию:  

3. Сохраните изображение в своей папке в формате Jpeg, командой Фал – 

Сохранить как …, выберите папку для сохранения, укажите название и в окне тип файлов 

укажите формат Jpeg, при запросе о качестве выберите лучшее. 

4. Сформулируйте цель практикума 

 

 



 

 

 

 

Практикум №10 

 

Тема: Изучение возможностей меню CorelDRAW» 

Цель: 

Теоретическая часть 

Разработчики Corel Draw стремились сделать эту программу доступной как можно 

более широкому кругу пользователей. Однако, вряд ли найдется двое пользователей, 

работающих одинаково. Именно поэтому при создании Corel Draw была предусмотрена 

возможность настройки интерфейса соответственно вкусам пользователя. 

Вообще интерфейс Corel Draw напоминает мастерскую художника. Сам рисунок 

находится на мольберте. Инструменты - карандаши, перья, линейки и т.д. - можно 

разложить так, чтобы вам было удобнее работать. Здесь вы можете добавлять, удалять и 

модифицировать следующие элементы: 



 рабочие пространства; 

 клавиатурные эквиваленты; 

 меню и их команды; 

 кнопки панели инструментов; 

 докеры; 

 цвета на цветовой палитре; 

 каталоги(свитки); 

Рабочие пространства 

Рабочее пространство - это среда, в которой вы разрабатываете свое 

приложение. Corel Draw - многофункциональный редактор. Вы можете разрабатывать 

Web-страницу, выполнять макетирование страниц или просто рисовать. В каждом 

конкретном случае вам могут понадобиться функции, которые вы используете только в 

данном случае и нигде больше. В Corel Draw 8 и выше можно создать и полностью 

сохранить свою рабочую среду. Эта возможность в сочетании с шаблонами делает Corel 

Draw способной автоматически подготовить рабочую среду и настроить все параметры. 

Создать новое рабочее пространство несложно. Просто выберите в диалоговом 

окне Options категорию Workspace и щелкните на кнопке New (Создать), находящеся во 

вкладке Workspace. В результате появится диалоговое окно New Workspace (Новое 

рабочее пространство), содержащее следующие четыре опции: 

 Name of New Workspace (Имя нового рабочего пространства). Название 

опции говорит само за себя. Просто дайте новому рабочему пространству содержательное 

имя. 

 Base New Workspace On (Создать новое рабочее пространство на 

основе). Это очень удобная возможность создания нового рабочего пространства на 

основе другого, что существенно экономит время. Предположим, у вас есть рабочее 

пространство, предназначенное для создания рекламных проспектов. А вам понодобилось 

новое рабочее пространство, в котором вы также собираетесь создавать рекламные 

проспекты, но уже несколько другие. В этом случае, вместо того, чтобы все начинать 

сначала и создавать новое рабочее пространство на основе стандартного, можно создать 

его на основе уже существующего пространства, внеся лишь небольшие необходимые 

изменения. 

 Description of Workspace (Описание рабочего пространства). Как видно из 

названия, это - описание рабочего пространства. 



 Set as Current Workspace (Определить как текущее рабочее 

пространство). Установив этот флажок, вы сделаете новое рабочее пространство 

активным для текущего документа. 

 

Работа с меню Corel Draw 

При работе с Corel Draw вам не обойтись без использования меню и их команд. Их 

здесь огромное количество и они позволяют вам в полной мере использовать возможности 

этого графического редактора. Но не все они нужны вам постоянно. А многих огромное 

количество меню, команд, всплывающих подсказок и сообщений просто угнетает. 

Некоторые же, напротив, для выполнения повторяющихся, рутинных операций хотели бы 

создать новую структуру меню. 

Как это сделать? Модификация меню Corel Draw выполняется с помощью опций 

вкладки Menu (Меню) диалогового окна Options. Чтобы получить к ней доступ, выберите 

команду 

Tools→Options→Customize→Menu 

(Сервис→Параметры→Настройка→Меню). 

С помощью этой вкладки можно выполнять следующие операции: 

 добавление, удаление и перемещение меню; 

 добавление, удаление и перемещение подменю; 

 добавление, удаление и перемещение команд в меню; 

 добавление к меню стилей и сценариев; 

Рассмотрим эти операции подробнее. 

Если открыть в диалоговом окне Options вкладку Customize и щелкнуть на 

папке Menu, то Corel Draw отобразит текущую структуру меню. В 

списке Commands перечислены все имеющиеся функции, включая опции многих 

каталогов, а также созданные вами стили и сценарии. В этом списке нужно выбрать 

элементы, которые будут включены в новую структуру меню. С помощью 

расположенного справа списка Menus можно конструировать новые меню и 

модифицировать существующие. 

При выполнении настройки самой строки меню (расположенной в верхней части 

экрана) из раскрывающегося списка Menu должен быть выбран элемент main Menu 

(Основное меню). (Другими элементами этого раскрывающегося списка являются 

контекстные меню, сгруппированные по смыслу.) 

Для добавления меню щелкните на кнопке Add Menu (Добавить меню), и в списке 

появится новое меню. Место для его имени будет выделено автоматически, так что вы 



сможете его ввести. Поскольку меню совершенно новое, оно не содержит никаких команд 

или опций. О том, как их добавить, указано дальше. 

Для удаления меню выберите его в списке Menu, а затем щелкните на 

кнопке Remove (Удалить). Имейте в виду, что при этом удаляются также и все команды 

меню. Это означает, что они становятся недоступными (за исключением тех случаев, 

когда эти команды есть в каталогах или им присвоены клавиатурные эквиваленты). 

Удаленные команды или опции можно перенести в другие меню. 

Чтобы изменить положение некоторого меню в строке меню, выберите его, а затем 

щелкните на кнопке Move Up (Переместить вверх) или Move Down (Переместить 

вниз). Таким образом вы сможете поместить меню в нужном месте. 

Подменю или вспомогательные меню входят в состав основного меню. С их 

помощью можно добавлять к меню дополнительные опции. Например, Order 

(Порядок) из меню Arrange (Монтаж) - это типичное подменю, из которого можно 

выбрать такие команды, как To Back (Поверх всех), To Front (Ниже всех) и т.д. В 

подменю могут содержаться команды, сценарии и стили, а также другие подменю. 

Процедуры добавления, удаления и перемещения меню и подменю аналогичны. Разница 

лишь в том, что в раскрывающемся списке должно отображаться имя соответствующего 

подменю. 

Чтобы добавить подменю, дважды щелкните на том меню, в которое вы хотите его 

включить. Имя меню должно появиться в раскрывающемся списке Menu. Щелкните на 

кнопке Add Menu, а затем дайте подменю какое-либо имя (как при добавлении нового 

меню к строке меню). 

Для удаления подменю нужно выбрать его и щелкнуть на кнопке Remove. Как и в 

случае меню, при этом удаляются все команды и опции подменю. Для изменения 

положения подменю в меню используются кнопки Move Up и Move Down. 

Все элементы меню фирма Corel называет командами; причем этими элементами 

могут быть стили, сценарии, опции каталогов и обычные команды. В меню можно 

включать стили и сценарии, созданные в шаблоне документа, а также устаовленные 

опции. 

Чтобы добавить команды (т.е. стили, сценарии, команды и т.д.) к меню или 

подменю, выполните следующие действия: 

 В списке Menu дважды щелкните на меню или подменю, к которому вы 

хотите добавить (или удалить) команду. 

 Прокрутите расположенный слева список Commands, найдите нужную 

команду и выделите ее. 



 Щелкните на кнопке Add или Remove. 

 Для перемещения некоторого элемента вверх или вниз по меню 

воспользуйтесь кнопками Move Up или Move Down. 

Добавление стилей к меню выполняется аналогично. Единственное отличие 

состоит в том, что стили добавляются из папки Apply Styles в списке Commands. 

1. Сделайте краткий конспект и закройте обучающую программу Teach Pro 

Corel Draw. 

2. Сформулируйте цель практикума 

 

 

Практикум №11 

 

Тема: «Изучение панели инструментов, цветовой палитры Corel Draw» 

Цель: 

Панели инструментов 

Панель инструментов - это полоса, на которой содержатся кнопки или 

пиктограммы, позволяющие быстро получить доступ к командам и другим функциям 

программы. В Corel Draw включено несколько готовых панелей инструментов. Вы можете 

либо модифицировать встроеннные панели, либо создать собственные. Сделать это можно 

при помощи команды View→Toolbars(Вид→Панели инструментов). На экране 

появляется диалоговое окно Options. В этом окне можно указать, какие панели и как 

должны отображаться, а также создавать новые панели. 

С помощью опций владки Customize диалогового окна Options можно добавлять, 

удалять и переупорядочивать кнопки панелей инструментов. Чтобы получить доступ к 

опциям, нужно выбрать команду View→Toolbars (Вид→Панели инструментов) или 

дважды щелкнуть на вкладке диалогового окна Options. В обоих случаях на экране 

появится диалоговое окно. В любом случае, прежде чем проводить настройку панели 

инструментов, отобразите ее на экране, выбрав нужную панель в списке Toolbars (Панели 

инструментов). 

В поле Commands (Команды) содержатся все существующие команды и опции, 

которые можно назначать панелям инструментов (но только назначать можно не любые 

опции из этого списка; немного позже вы узнаете, какие можно, а какие - нет). При 

выборе папок имеющиеся опции панели инструментов отображаются с правой стороны 

окна. Справа, на палитре Buttons (Кнопки) , показаны все имеющиеся кнопки для 

выбранной категории. Например, если выбрать в 



поле Commands элемент Text→TextFormatting (Текст→Форматирование текста), то 

справа вы увидите все кнопки и поля, предназначенные для изменения атрибутов текста. 

Чтобы добавить кнопку или поле к панели инструментов Text (Текст), просто перетащите 

ее или его из этого диалогового окна на панель инструментов. Чтобы удалить кнопку, 

соответственно, перетащите ее с панели инструментов. Для изменения положения кнопок 

на панели нужно просто перетащить их в то время, когда открыто диалоговое 

окно Options. 

Группы каталогов 

Одна из наиболее полезных возможностей Corel Draw - использование каталогов. 

Это наборы команд, с помощью которых можно выполнять различные операции над 

объектами рисунка. Они отличаются от меню и панелей иструментов тем, что к ним 

нельзя добавлять опции и удалять их. Однако, для удобства работы можно создавать 

группы, состоящие из определенных каталогов. Кроме того, можно указать стандартное 

местоположение каждого каталога в окне программы. 

Группы каталогов - это комбинации нескольких каталогов, имеющих сходные 

функции. Например, группа каталогов Effects (Эффекты) содержит все каталоги, которые 

используются для создания спецэффектов, таких как добавлеие перспективы, переход 

между объектами, выдавливание и т.д. Группы каталогов весьма удобны, так как 

позволяют свести воедино и упорядочить большое количество каталогов, накопившихся в 

Corel Draw за долгие годы. 

В Corel Draw есть несколько готовых групп каталогов; вы можете либо 

модифицировать их, либо создать собственные группы. Модифицировать группы 

каталогов в окне программы можно с помощью метода "перетащить и отпустить"; а для 

создания новых групп используется вкладка Roll-Ups (Свитки) диалогового 

окна Customize, вложенного в диалоговое окно Options. 

Хотя для большинства случаев конфигурация каталогов Corel Draw вполне 

подходит, для удобства выполнения специфических задач вы можете создавать 

собственные группы. Чтобы модифицировать группу каталогов, выберите 

команду View→Roll-Ups (Вид→Свитки), а затем - нужную группу. Теперь можно 

выбрать один из вариантов действий: 

 Чтобы отделить каталог от текущей группы, просто перетащите его из 

списка группы каталогов. 

 Чтобы переместить каталог из одной группы в другую, перетащите его из 

одного списка группы каталогов в другой. 



 Чтобы объединить два каталога или добавить один каталог к существующей 

группе, во время перетаскивания удерживайте нажатой клавишу . При перетаскивании 

каталога курсор превратится в стрелку с пиктограммой этого каталога. 

При объединении двух отдельных каталогов Corel Draw позволяет присвоить новой 

группе любое имя на ваш вкус. Просто откройте диалоговое окно Options (выберите 

команду Tools→Options), выберите вкладку Customize→Roll-Ups и щелкните на 

кнопке New Group (Создать группу). Затем щелкните на элементе New Group 1 (Новая 

группа 1) правой кнопкой мыши, выберите в контекстном меню команду Rename и 

введите новое имя группы каталогов. 

Создавать и модифицировать группы катологов можно не только в окне 

программы, но и в диалоговом окне Options. В папке Customize→Roll-Ups диалогового 

окна Options отображаются все каталоги и группы каталогов в том же порядке, в каком 

они появляются по правой и левой сторонам окна. Другими словами, порядок их 

расположения точно такой же, как и при выборе команды Arrange All (Упорядочить 

все) из вспомогательного меню любого каталога (оно появляется после щелчка правой 

кнопкой мыши на строке заголовка каталога). 

Процедура модификации групп каталогов в этом диалоговом окне выполняется во 

многом так же, как создание новых меню и упорядочение команд меню. Чтобы добавить 

каталог к существующей группе, откройте ее с помощью двойного щелчка, а затем 

воспользуйтесь кнопками Move (Переместить) или перетащите каталог в группу. В этом 

диалоговом окне можно также поменять сторону, по которой выравнивается некоторый 

каталог при выборе команды Arrange All. Чтобы изменить порядок следования каталогов, 

просто перетащите пиктограмму какого-либо каталога вверх или вниз в списке. Чтобы 

создать новую группу, щелкните на кнопке New Group (Создать группу), назовите 

группу, а затем переместите в нее нужные каталоги. 

Докеры 

Самым крупным недостатком диалоговых окон является то, что их нужно 

открывать, вносить необходимые изменения, а затем закрывать. Если же полученный 

результат вам не понравится, придется вновь открывать диалоговое окно и все начинать 

сначала. Фирма Corel взялась за решение данной проблемы, и в результате были созданы 

интерактивные диалоговые окна, которые называются докерами (dockers). Это диалоговые 

окна, работающие по принципу панелей инструментов и каталогов, т.е. вам не придется 

закрывать и вновь открывать их, чтобы увидеть результаты внесенных изменений. Чтобы 

просмотреть список имеющихся докеров, выберите команду View→Dockers 

(Вид→Докеры). 



Вы можете открыть одновременно несколько докеров. При этом все они, кроме 

активного, отображаются и закрепляются по левой стороне окна приложения. Но, как и 

панели инструментов, их можно перемещать к правой, верхней или нижней стороне окна 

либо делать плавающими. Как и в случае каталогов, можно создавать группы докеров 

методом перетаскивания, чтобы отображать на экране сразу несколько докеров. 

Палитра цветов 

В Corel Draw имеется возможность изменять внешний вид и положение палитры 

цветов. Это дает возможность непосредственного доступа ко всем элементам без 

прокрутки вперед и назад. Чтобы изменить внешинй вид палитры цветов, щелкните на 

элементе Color Palette (Цветовая палитра) вкладки Customize диалогового окна Options 

(Tools→Options→Customize→Color Palettes). 

Если размер экрана монитора относительно небольшой, а разрешение высокое, то 

образцы цветов палитры будут слишком малы. Решить эту проблему поможет 

опция Large Swatches (Крупные ячейки) вкладки Color Palette диалогового окна Options. 

На экранах больших мониторов с высоким разрешением иногда приходится очень 

долго перемещать указатель мыши, чтобы попасть из области рисования на цветовую 

палитру. Эту проблему можно решить, сделав палитру плавающей или прикрепив ее к 

верхней или левой стороне экрана. Размеры плавющей палитры изменяются точно так же, 

как и размеры панели инструментов. Чтобы сделать палитру плавающей, перетащите ее, 

"ухватив" за серую область вокруг цветных ячеек. После этого можно изменить размеры, 

перетащив стороны (как и в случае панели инструментов). 

Чтобы прикрепить палитру к верхней или левой стороне окна, перетащите ее в 

нужное место. По положению контура палтиры вы сможете определить, попала ли она в 

нужное место. После того, как вы отпустите кнопку мыши, палитра будет прикреплена. 

Фильтры 

Фильтры - это небольшие программки, которые преобразуют "неродные" для 

приложения форматы файлов в формат, который может использоваться в данном 

приложении. В поставку Corel Draw входит так много фильтров, что использовать для 

работы с ними диалоговые окна Import (Импорт) и Export (Экспорт) довольно неудобно. 

Для этого предусмотрена вкладка Filters диалогового окна Options, доступ к которой 

можно получить с помощью команды Tools→Options→Global→Filters 

(Сервис→Параметры→Глобальные→Фильтры). C ее помощью вы сможете, если 

понадобится, добавить или удалить фильтры. 

В списке Available file types (Существующие типы файлов) перечислены 

имеющиеся типы файлов, или фильтров. Они поделены на четыре группы - растровые, 



векторные, текстовые и анимация. В списке справа перечислены активные фильтры, т.е. 

имеющиеся на момент вызова из меню File (Файл) команды Import или Export. 

Для добавления фильтра к списку активных откройте соответствующую группу в 

списке слева, выберите нужный фильтр, а затем щелкните на кнопке Add (Добавить). Для 

удаления фильтра просто выберите его в списке справа, а затем щелкните на 

кнопке Remove (Удалить). С помощью кнопок Move Up и Move Down можно также 

изменить порядок следования фильтров в диалоговых окнах Import и Export. Просто 

выберите фильтр, который вы хотите переместить вверх или вниз, а затем щелкните на 

соответствующей кнопке. 

Ассоциации 

Функция Associate позволяет ассоциировать форматы файлов с конкретным 

приложением пакета Corel Draw. Это дает вам возможность использовать и редактировать 

файлы практически любых форматов, не приобретая какие-либо другие приложения. Все, 

что нужно, вы найдете в Corel Draw. 

Ассоциации определяются во вкладке Associate (Ассоциации) диалогового 

окна Options (Tools → Options → Global → Filters →Associate (Сервис → Параметры → 

Глобальные → Фильтры → Ассоциации)). Чтобы ассоциировать любой тип файла из 

списка Associate с Corel Draw, просто установите соответствующий флажок. Если вы 

хотите ассоциировать файлы с другими приложениями пакета Corel Draw, например с 

Photo-Paint, откройте это приложение и выполните аналогичную процедуру. 

Панель свойств 

С технической точки зрения панель свойств - это та же панель инструментов, 

поэтому и модифицируются они практически одинаково. Чтобы настроить панель 

свойств, нужно воспользоваться опциями вкладки Toolbars диалогового окна Options 

(Tools → Options → Customize → Toolbars). 

Главное различие между панелью свойств и другими панелями инструментов 

заключается в том, что панель свойств является контекстно-зависимой. Другими словами, 

она меняется в зависимости от рабочей ситуации. Например, при форматировании текста 

на панели свойств появляются опции, имеющие отношение к атрибутам текста, таким как 

размер в пунктах, гарнитура и т.д. Поэтому, если вы хотите изменить свойства какого-

либо элемента, вам следует перейти к этому элементу, а затем уже изменять 

конфигурацию панели свойств. 

Практическое задание: откройте программу и изучите меню 

3. Загрузите обучающую программу по Corel Draw 10 следующим 

образом: Пуск / Программы / Teach Pro / Teach Pro Corel Draw. 



4. После загрузки программы Вам надо зарегистрироваться в программе, 

используя команду Регистрация, введите свое имя и нажмите ОК. 

5. Нажав кнопку Дальше Вы попадаете в главное меню программы. 

На этом уроке Вы должны познакомиться со следующими пунктами первого урока 

– Знакомство с программой: 

 Запуск программы; 

 Главное меню, панели инструментов управления и свойств; 

 Строка состояния, контекстное меню, палитра цветов и докеры; 

 Масштаб изображения, измерительная линейка; 

 Окно документа. Открытие документа. 

6. Войдя в выбранный фрагмент, необходимо ознакомиться с панелью 

управления системы TeachCorel. Для ее появления надо поместить курсор мыши в 

нижнюю часть экрана. В левой части панели находятся режимы обучения и клавиши 

управления демонстрацией. Режимы обучения содержат в себе следующие виды: фильм, 

шаг, контроль и тест. Мы будем работать в режиме фильм. Клавиши управления 

демонстрацией включают в себя кнопки стоп, старт, пауза, шаг вперед и шаг назад, 

переход в начало урока и в конец урока. С правой стороны панели: закладки, подсказки, 

справка и переход к главному меню программы. Познакомьтесь подробнее с этим меню. 

Работа с цветом 

Условием правильного использования цвета является понимание различных 

способов интрепретации цвета, лежащих в основе имеющихся математических моделей 

цвета. Для професиональной работы по созданию цветных рисунков, коллажей и цветных 

векторных или точечных изображений необходимо постоянно отслеживать возможности, 

предоставляемые новыми графическими средствами. 

Использование диспетчера цветов 

Задачей диспетчера цветов является сопоставление цветовых диапазонов всех 

устройств, используемых в настольной издательской системе для обеспечения 

согласованного вывода цветов этими устройствами. Конфигурации отдельных устройств 

служат блоками, используемыми при построении системной конфигурации. 

В зависимости от характера решаемых задач и квалификации 

пользователя, Диспетчер задач позволяет выполнить один из следующих вариантов 

настройки: 

 Быстрое создание системной конфигурации путем использования 

встроенных конфигураций отдельных устройств системы. 



 Создание специальных конфигураций устройств, позволяющих 

оптимизировать системные конфигурации за счет компенсации вариаций параметров 

имеющегося оборудования, старения оборудования или изменения условий работы. 

Вызов Color Manager (Диспетчер цветов) можно осуществить путем выбора 

команды Tools -> Color Manager (Сервис - >Диспетчер цветов). В результате появиться 

диалоговое окно. 

Диспетчер цветов обеспечит необходимую помощь на всех этапах работы по 

выбору или созданию следующих конфигураций: 

 Конфигурация сканера. 

 Конфигурация монитора. 

 Конфигурация принтера. 

 Системная конфигурация. 

После завершения работы с конфигурациями устройств диспетчер цветов 

автоматически создает системную конфигурацию. 

Понятие цветовых моделей 

CorelDraw 7 располагает развитым интерфейсом для выбора нужной цветовой 

модели и цвета внутри нее. 

Типы цветовых моделей подерживаемых CorelDraw 

Цветовые модели используются для математического описания определенных 

цветовых областей спектра. В большинстве моделей используются три основных цвета, 

соответсвующих восприятию цвета человеческим глазом. Каждому основному цвету 

присваивается определенное значение, после чего все остальные цвета определяются как 

комбинация основных цветов. Именно такой принцип использует художник при создании 

картины на базе ограниченной палитры цветов. 

Для реализации доступа к цветовым моделям CorelDraw и интерактивного выбора 

нужного цвета необходимо открыть окно диалога "Uniform Fill" (Однородная заливка). 

При наличии выделенного объекта это можно сделать одним из следующих 

способов: 

 С помощью комбинации клавиш Shift + F11. 

 Нажать мышью на значок интсрумента Fill (Заливка) на панели 

инструментов "Графика" с последующим выбором из открывающейся панели 

инструментов "Fill flyout"(Заливка) кнопки Fill Color Dialog (Диалог Однородная заливка). 

 Выбрать опцию Uniform Fill из раскрывающегося списка Fill Type (Тип 

заливки) на панели инструментов "Property Bar", отображаемом после выбора 

инструмента Interactive (Интерактивная заливка). 



В окне диалога "Uniform Fill" (Однородная заливка) установлены заданные по 

умолчанию цветовые параметры. Нажатие кнопки Color Models открывает доступ к 

списку из десяти цветовых моделей, отображаемых в поле Model (Модель): CMY, CMYK, 

CMYK255, RGB, HSB, HLS, Lab, YIQ, Grayscale (Оттенки серого) и Registration 

Color (Цвет для приводки). 

Рассмотрим некоторые их них. 

RGB 

Большинство цветов видимого спектра могут быть получены путем смешивания в 

различных пропорциях трех основных цветовых компонент. Этими компонентами, 

которые в теории цвета называют первичными цветами, являеются красный (Red), 

зеленый (Green) и синий (Blue). 

Первичные цвета так же называют аддитивными, поскольку в результате их 

объединения (сложения) получается белый цвет. 

Аддитивные цвета широко используются в системах освещения, в видеосистемах, 

устройствах записи на фотопленку и мониторах. При попарном смешивании первичных 

цветов образуются вторичные цвета: голубой (Cyan), пурпурный (Magenta) и желтый 

(Yellow). 

Следует отметить, что первичные и вторичные цвета относятся к базовым цветам, с 

помощью которых можно получить практически весь спектр видимых цветов. Цветовая 

модель RGB является в настоящее время самой распространенной и популярной. 

 

Рис.1 Управление цветовой моделью RGB 



На рис.1 приведено окно диалога с элементами управления 

параметрами RGB цветовой модели. Предусмотрено несколько способов установки 

нужного цвета. Один из них - интерактивный способ, реализуемый путем перетаскивания 

с помощью мыши маленького квадратного маркера внутри цветового поля квадратного 

графического элемента. Таким образом, каждой из трех цветовых компанет (R, G, B) 

можно задать величину интенсивности в диапозоне от 0 до 255, чтобы обеспечить 24-

битовую глубину цвета. Расположенный справа от квадрата вертикальный селектор 

изменяет значение яркости, геометрически масштабируя все текущие значения R, G, B 

компонент. Так же можно установить нужный цвет путем ввода с клавиатуры значений 

интенсивности каждой компоненты RGB модели в соответствующие поля ввода или 

установкой этих значений с помощью кнопок счетчиков. 

CMY 

Эта цветовая модель используется в том случае, если изображение или рисунок 

будут выводиться на трехцветном принтере. В ее основе лежит использование 

трех субтрактивных (вторичных) цветов: голубого (Cyan), пурпурного (Magenta) и 

желтого (Yellow). 

Субтрактивные цвета в отличие от аддитивных цветов (например RGB модели) 

получаются вычитанием другого цвета из общего луча света. В этой системе белый цвет 

появляется как результат отсутствия всех цветов,тогда как их присутствие дает черный 

цвет. Система субтрактивных цветов работает с отраженным светом, например от листа 

бумаги. 

При смешивании трех основных субтрактивных цветов на белой бумаге в равной 

пропорции получается черный цвет. Однако, в действительности этот цвет выгладит 

темно-коричнывым, потому что типографиские краски поглощают свет не полностью. 

Каждый из основных цветов CMY цветовой модели допускает 255 градаций яркости, что 

соответствует 24-битовой глубине цвета. После выбора CMY цветовой модели 

открывается окно диалога, аналогичное рассмотренной ранее RGB модели, с теми же 

элементами выбора нужного цвета. 

CMYK 

Одна из самых популярных моделей (рис.4) которая базируется на четырех 

основных цветах принтера. Она является естественным развитием CMY цветовой модели 

путем добавления к ней черной компоненты цвета для получения при печати настоящего 

черного цвета. В этом случае воспроизведение цветов достигается путем смешивания 

четырех красок: голубой (Cyan), пурпурной (Magenta), желтой (Yellow) и черной (Black). 



Интенсивность голубой (С), пурпурной (М) и желтой (Y) компонент цвета модеть 

быть установлена интерактивным способом путем перетаскивания мышью маленького 

квадратного маркера внутри цветового квадрата. Интенсивность черной (К) компоненты 

цвета усиливается устанавливается с помощью перемещения движка вертикального 

селектора, расположенного справа от цветового квадрата. 

При использовании CMYK цветовой модели следует помнить, что не все 

получаемые с помощью нее цвета, могут быть воспроизведены на экране монитора или 

напечатаны принтером. 

CMYK255 

По составу базовых цветов цветовая модель CMYK255 аналогична 

традиционной CMYK модели. Однако в отличие от нее, здесь для каждой компоненты 

цвета используется 8-битовое разрешение, что допускает 255 градаций яркости. В 

результате суммарная глубина цвета, характеризиующая количество воспроизводимых 

цветов (цветовой охват), составляет 32 бита, что намного превышает 

возможности RGB, CMY и CMYK цветовых моделей. Для установки нужного цвета с 

помощью окна диалога можно использовать те же приемы, что и для CMYK модели. 

HLS 

Модель HLS (Hue - оттенок, Lightness - интенсивность, Saturation - контрасность) 

представляет из себя вариант модели HSB. В них компоненты Hue (оттенок) и Saturation 

(контрастность) являются общими. 

Эта модель так же альтернативна модели RGB. В HLS модели для интерактивной 

установки цвета используются унифицированные для CorelDraw способы. Первый из них 

- интерактивный, позволяющий установить значение компонентов Hue (в диапазоне от 0 

до 360 градусов),Saturation и Lightness (обоих в интервале от 0 до 100 процентов) путем 

перетаскивания с помощью мыши маленького квадратного маркера внутри графического 

элемента. Расположенный справа вертикальный графический элемент позволяет 

регулировать значение яркости, геометрически масштабируя все текущие 

значения H, L и S компонент. 

Registration color (Цвет для приводки) 

Модель Registration color состоит из единственного цвета CMYK модели, для 

которого все ее компоненты С, М, Y и К имеют значение, равное 100%. Этот цвет может 

использоваться в качестве специальной метки, устанавливаемой вместо тех цветов, 

которые находятся вне цветового диапазона данного принтера. Он также идеально 

подходит для эмблем, номеров заданий печати или любой другой разметки. Однако его 

нельзя использовать в качестве цвета специальной палитры. 



Назначение цветовых палитр 

Под цветовой палитрой в CorelDraw понимается набор заранее определенных 

цветов. Выбор палитры определяется задачами, которые нужно решить. Рассмотрим 

некоторые палитры цветов. 

Система цветов FOCOLTONE 

Эта палитра была разработана одной из европейских компанй и содержит около 

750 цветов, предназначенных для упрощения процедуры создания ловушек цвета. 

Поскольку цвета этой палитры основаны на цветовой модели CMYK, то процесс 

цветоделения не приводит к добавлению новых слоев. 

Для просмотра цветовых ячеек, не отображенных в окне просмотра палитры, 

можно воспользоваться полосой проктутки. Для предствления цветов по именам надо 

выбрать команду Show Color Names (Показывать имена цветов) в раскрывающемся 

списке Color Options (Работа с цветами). 

Система цветов TRUMATCH 

Палитра TRUMATCH содержит свыше 2000 основных цветов, поддерживаемых 

большинством принтеров. 

TRUMATCH создала специальный электронный эквивалент своей системы цветов 

на базе компьютерной электронной системы (CEPS). Эта система основана 

на CMYK цветовой модели. В цветовой палитре цвета расположены по цвету (от красного 

до фиолетового), контрастности (от глубокий до пастельнных тонов) и яркости 

(добавление или удаление черного). Для отображения ячеек, не представленных в окне 

палитры, можно воспользоваться полосой прокрутки. 

Системой TRUMATCH разработан собственный спрособ кодировки цветов. 

Напрмер, цвет с уникальным именем 23-С2 может быть идентифицирован по его номеру. 

Первое число указывает на оттенок (цвет). 

Оттенки пронумерованы в соответствии с их расположением на цветовом круге. 

Буква указывает на величину контрастности. 

В имени цвета используется диапозон букв А (100%) до H (0%), для каждой из 

которых значение контрастности отличается от предыдущей на 5%. Цифра, следующая за 

буквой, указывает процентное содержание черного цвета в диапазоне от 0% (число 0) до 

42% (число 7). 

Цветовая палитра SpectraMaster 

Палитра основных цветов SpectraMaster разработана для использования в 

производстве промышленных покрытий и красителей. Она содержит свыше 2400 



различных цветов и основана на цветовой модели Lab. Для ее изображения на экране 

монитора используются RGB или CMYK модели, а для печати CMYK модель. 

Цвета из палитр DIC и палитры TOYO88 

Эти палитры цветов широко распространены в странах Азии, особенно в Японии. 

Каждая из них имеет собственную систему кодировки цветов и коллекцию из основных 

цветов. Цвета палитр DIC (DIC Color Guade, DIC Color Guade Part II и DIC Traditional 

Colors of Japan) создаются при смешивании красок DIC. В приложениях Corel 

воспроизведение цветов этой палитры выполняется в модели CMYK. 

Диапазон цветов палитры TOYO88 создается и воспроизводится с помощью 

красок TOYO. Репродуцирование цветов этой палитры на экране компьютера 

осуществляется с помощью RGB модели, а для печати - CMYK модели. Для согласовани 

этих двух моделей используется модель Lab. 

Палитры для сетей Интернет 

В CorelDraw 7 включены две новые палитры, которые можно использовать для 

создания изображений для сети Интернет. Эта палтира Netscape Navigator 

(TM) и палитра Microsoft Internet Explorer. Каждая из них, обладая 8-битовой глубиной, 

позволяет реализовать 256 цветов. Их использование гарантирует адекватное отображение 

созданных изображений браузерами Web. 

Цветовая палитра Lab Colors 

Это еще одна новая палитра, включенная в состав CorelDraw 7. Она построена на 

основе одноименной цветовой модели Lab и имеет те же компоненты цвета: 

интенсивность (L) и цветоность от зеленого до красного цвета и цветность от синего до 

желтого цвета. 

В плане ориентации на конкретную цветовую модель палита Lab 

Colors напоминает палитру Uniform Colors (Обычная), которая построена на 

базе RGB модели. В обоих моделях название цвета задается с помощью указания в начале 

имени названия цветовой модели с последующим отображением количественного 

содержания каждой компоненты соответствующей модели. 

Палитра пользователя USERINCS Colors 

Это очередная новая палитра CorelDraw 7. Вернее сказать это заготовка для 

палитры рис.5 которую пользователь может заполнить своими цветами, присвоив им 

собственные оригинальные имена. 

Создание собственной палитры 

Возможность создания собственно палитры - чрезвычайно ценное средство для 

компьютерных художников, активно работающих с присущим им набором цветов. 



Специализированные палитры также часто необходимы для использования в конкретных 

приложениях. Для создания с помощью средств CorelDraw специальной палитры 

выполните следующее: 

1. С помощью комбинации клавиш Shift+F11 или Shift+F12 откройте 

соответственно окно диалога "Uniform Fill" (Однородная заливка) или окно диалога 

"Outline Color" (Цвет контура). 

2. Нажмите кнопку Model (Модель) и выберите из раскрывающегося 

списка CMYK цветовую панель. 

В том случае, если вы открываете одно из перечисленных окон впервые, то в нем 

по умолчанию будет установлена именно эта модель. 

3. Нажмите кнопку Palette Options (Работа с палитрой), расположенную в правом 

нижнем углу окна диалога прямо за текущей палитрой пользователя Custom palette - 

Corelpnt.cpl, и из раскрываещегося меню выберите команду New Palette (Создать 

палитру). 

4. Наберите в текстовом поле Имя файла появляющегося окна диалога "New 

Palette" (Создание палитры) (рис.6) название вашей палитры, оставив тип файла, 

предлагаемый программой CorelDraw 7 (CPL) в поле Тип файла, без изменений, так как 

это расширение является стандартным для палитр Corel. Нажмите кнопку Сохранить. 

По умолчаню Corel будет сохранять файл с вашей палитрой в папке 

COREL\DRAW70\CUSTOM. 

После выполнения пункта 4 в окне диалога на месте текущей палитры пользователя 

устанавливается созданная вами и пока еще пустая специальная палитра. В последствии 

вы сможете заполнить ее путем создания свои неповторимые цвета. Рассмотрим в 

качестве примера способ заполнения созданной палитры цветами из CMYK цветовой 

модели, установленной в данный момент в окне диалога. 

5. Установите первый цвет палитры. Для этого можно воспользоваться 

интерактивным способом задания его соответствующих компонентов путем перемещения 

маленького квадратного маркера внутри квадратного цветового поля (компоненты С: 

(голубой), М (пурпурный) и Y (желтый)) и узкой полоски внутри вертикального 

графического элемента (компонент К (черный)). Проверьте его реальный цвет с помощью 

установленого в правом верхнем углу окна диалога индикатора New Color (Новый цвет) 

и, если он вас не устраивает, выполните точную подстройку его с помощью 

корректировки процентного содержания каждого из четырех 

компонентов С, М, Y и К путем нажатия кнопок соответствующих селекторов. 



6. Для установки этого цвета в созданную палитры нажмите расположенную в 

правом верхнем углу окна диалога кнопку Color Options (Работа с цветами) и из 

раскрывающегося меню выберите команду Add Color to Palette (Добавить цвет в 

палитру). Вы сможете добавить новый цвет в палитру, нажав мышью определенную точку 

квадратного цветового поля, с последующим выбором этой же команды. 

7. Присвойте вновь созданному цвету наименование. Для этого введите в текстовое 

поле Name (Цвет) его название. 

Старайтесь использовать имена, соответствующие названию объекта, для которого 

они будут предназначаться, или области, которая будет ими закрашена. Не называйте их 

Red или Blue, така как монитор не воспримет их. В название имени можно включать до 32 

букв, как верхнего, так и ниженего регистров. 

8. После введения в текстовое поле названия цвета нажмите кнопку Palette 

Options (Работа с палитрой) и из раскрываегося меню выберите команду Rename 

Color (Переименовать цвет). Теперь вашему цвету присвоено оригинальное 

название (рис.7). 

9. Для добавления в созданную палитру новых цветов повторите пункты с 5 по 7, 

установив необходимое количество цветов. 

10. Для сохранения цветов, добавленных в вашу палитру, нажмите кнопку Palette 

Options (Работа с палитрой) и из раскрываюегося меню выберите команду Save 

Palette (Сохранить палтиру). 

Синтез новых цветов 

В CorelDraw 7 предусмотрено два способа создания новых цветов: Color 

Blender (Сетка цветов) и Mixing Area (Область смешивания). Кнопки для активизации 

этих режимов расположены в правом верхнем углу окон диалога "Uniform Fill" 

(Однородная заливка) и "Outline Color" (Цвет контура) под кнопками выбора цветовых 

моделей и палитр. Эти способы обеспечивают возможность синтеза оригинальных цветов. 

Для описания создаваемых ими цветов можно 

использовать RGB, CMYK или HSB цветовые модели, одну из которых надо 

предварительно установить путем нажатия кнопки Color models (Цветовые модели). 

Работа в режиме Mixing Area (Область смешивания) 

В результате выбора этого режима открывается область смешивания, 

выполняющая функции электронной палитры с нанесенными на ее поверхность 

первичными цветами в форме окружностей. Синтез цветов осуществляется с помощью 

двух инструменов Eyedropper (Пипетка) и Paint (Кисть), расположенных над левым 

верхним краем области смешивания. 



С их помощью пользователь может создавать собственные цвета, как бы имитируя 

процесс физического перемешивания красок на традиционной палитре. Это достигается с 

помощью выбора иструментом Eyedropper (Пипетка) цветов области смешивания и 

добавления в нее новых цветов инструментом Paint (Кисть) из текущей палитры 

пользователя. Выбранный вами цвет отображается в поле цветового индикатора New 

Color (Новый цвет).Можно заменить этот цвет на другой, нажав мышью на 

соответствующую цветовую ячейку палитры. (рис.8) 

Можно регулировать прозрачность добавляемого в палитру цвета путем 

перемещения движка, задающего значение параметра Blend (Доля), расположенного под 

областью электронной палтиры. Устанавливая это значение от 0 до 100 процентов, можно 

управлять прозрачностьювносимого в палитру цвета от абсолютно непрозрачного до 

полностью прозрачного. 

Для настройки инструмента Paint (Кисть) выполните следущее: 

1. Нажмите кнопку раскрывающегося списка Color Options (Работа с цветами) или 

вызовите контекстное меню, нажав правой кнопкой мыши на области смешивания. 

2. Выберите опцию Brush size (Размер кисти) и установите один из трех размеров 

кистей: Small (Мелкая), Medium (Средняя) и Large (Крупная). 

3. Выберите опцию Brush Type (Тип кисти) и установите один из трех типов 

кистей: Hard (Жесткая), Medium (Средняя) и Soft (Мягкая). 

Новый цвет, получаемый в результате смешивания исходных цветов области 

смешивания с добавляемыми в нее цветами из текущей палитры, может быть установлен в 

текущую палитру с помощью следующих шагов: 

1. Выберите инструмент Eyedropper (Пипетка) и нажмите мышью созданный вами 

новый цвет. Подтверждением сделанного явится установка этого цвета в поле цветового 

индикатора New Color (Новый цвет). 

2. Нажмите кнопку Color Options (Работа с цветами) и из раскрывающегося меню 

выберите команду Add Color To Palette (Добавить цвет в палитру). 

Работа в режиме Color Blender (Сетка цветов) 

Режим Color Blender (Сетка цветов) предназначен для создания смеси из четырех 

цветов с последующим выбором нужного цвета из синтезированного таким образом 

набора цветов. Эти цвета устанавливаются по углам квадратной сетки путем их выбора из 

текущей цветовой палитры. Они могут быть заданы с помощью одной из трех цветовых 

моделей: RBG, CMYK или HSB. Квадратная сетка, используемая для смешивания цветов, 

имеет набор разрешений в диапазоне о 3х3 до 25х25, доступ к которым осуществляется с 

помощью команды Color Options / Grid size (Работа с цветами/Размер сетки) (рис.9). 



Использование крупной сетки приводит к более грубым градациям цвета, в то же время 

как мелкая сетка обеспечивает набор более тонких градаций цвета. 

Кнопка Auto-Blend (Смешать) управляет процессом смешивания цветов. Когда она 

нажата, происходит автоматическое смешивание четырех установленных в углах цветов. 

Это происходит каждый раз при очередной установке нового цвета в одном из углов сетки 

или изменения размера ячейки сетки. Для изменения одного из угловых цветов нажмите 

мышью соответствующую ему кнопку и выберите из раскрывающейся палтиры нужный 

цвет. Поскольку раскрывающиеся палитры идентичны палитре, отображаемой в окне 

диалога, для установки нового углового цвета можно также использовать механизм 

перетаскивания нужного цвета из текущей палитры на место заменяемого углового цвета. 

Чтобы добавить один из синтезированных цветов в текущую палитру , сначала 

выделите его нажатием мыши на соотвутствующей ячейки сетки и затем выберите 

команду Add Color To Palette (Добавить цвет в палитру) из раскрывающего меню Color 

Options (Работа с цветами). Если вы захотите включить в текущую палитру все 

синтезированные вами цвета, необходимо воспользоваться командой Add Grid Color To 

Palette (Добавить все цвета в палитру). 

Выделение новых цветов из сканированных точечных изображений 

CorelDraw имеет возможность использования режима Mixing Area (Область 

смешивания) для импорта точечных изображений. 

После импорта в область смешивания точечного изображения, его можно 

использовать как источник новых цветов при формировании собственной палитры или 

расширения имеющейся цветовой палитры. Для выборки нужного цвета используется 

инструмент Eyedropper (Пипетка) с последующим отображением его компонент с 

помощью четырех моделей: RGB, CMYK, HSB и Lab. 

Для работы с точечными изображениями предусмотрено применение трех 

команд: Load Bitmap (Загрузить точечное изображение), Save Bitmap (Сохранить 

точечное изображение) и Clear Bitmap (Очистить точечное изображение), 

расположенных в раскрывающемся меню Color Options (Работа с цветами). 

Для подготовки и импорта сканирования точечного изображения в область 

смешивания необходимо выполнить следующие шаги: 

1. Просканируйте изображение с помощью PHOTO-PAINT или какой-либо другой 

графической программы. Для обеспечения захвата возможно большего количества 

цветовых деталей выполните сканирование с разрешением не менее 150 dpi. 

2. Откройте изображение в CorelDraw и выполните необходимую корректировку 

цвета, яркости и контраста. При необходимости измените размер изображения. В 



противном случае, если размер изображения превысит 170 пикселей в ширину и 120 

пикселей в высоту, то в области смешивания будет отображена только часть изображения. 

3. Для реализации быстрого доступа к созданному точечному изображению 

сохраните его в папке COREL\DRAW\CUSTOM, которая при загрузке точечного 

изображения просматривается Corel самой первой. 

4. С помощью уоманд Shift+F11 или Shift+F12 откройте одно из окон диалога 

"Uniform Fill" (Однородная заливка) или "Outline Color" (Цвет контура). 

5. Нажмите кнопку Mixing Area (Область смешивания). 

6. Нажмите кнопку Color Options (Работа с цветами) и выберите команду Load 

Bitmap (Загрузить точечный рисунок). Затем установите в открывающемся окне диалога 

"Load Mixing Area File" (Загрузка области смешивания) нужную папку и файл с BMP 

расширением. После этого в область смешивания будет загружено точечное 

изображение (рис.10). 

7. Выберите инструмент Eyedropper (Пипетка), расположенный над левым 

верхним краем области смешивания. При желании можно открыть новую палитру и 

начать ее заполнение цветами загруженного в область смешивания точечного 

изображения. Чтобы открыть новую палитру, нажмите кнопку Color Options (Работа с 

цветами) и из раскрывающегося списка выберите команду New Palette (Создать палитру). 

Затем введите в поле Имя файла открывающегося окна диалога "Создание палитры" 

название созданной вами палитры и сохраните ее, нажав кнопку Создать. 

8. С помощью интсрумента Eyedropper (Пипетка) и команды Color Options/Add 

color To Palette (Работа с цветами/Добавить цвет в палитру) произведите выборку 

характерных цветов точечного изображения и добавьте их в созданную палитру. 

Созданная вами на базе точечного изображения собственная цветова палитра 

впоследствии может сделать вашу работу более эффективной. 

Задания: 

1. Сделайте конспект материала 

2. Сформулируйте цель практикума 

 

Практикум №12 

 

Тема: «Основы работы в программе Corel DRAW» 

Цель: 

Создание простых объектов 

Линии 



Для рисования линий в Corel Draw используется инструмент Freehand/Bezier 

(Кривая/кривая Безье), который находится в стандартной панели инструментов. Его 

значок выглядит следующим образом: 

 

В редакторе Corel Draw используются два режима рисования линий: 

 кривая (freehand); 

 кривая Безье (Bezier); 

Выбор инструмента зависит от вида контура, который вы хотите получить. Если 

вам нужно нарисовать прямую линию, то вам следует воспользоваться 

инструментом Bezier. Преимущество этого метода состоит в том, что вам нужно щелкнуть 

там, где должна начинаться линия, а затем там, где она должна заканчиваться. Если нужно 

присоединить к полученной линии еще один сегмент, просто щелкните еще раз в 

соответствующей точке - и Corel Draw автоматически соединит новый и старый сегменты. 

И так можно продолжать до бесконечности, добавляя все новые и новые сегменты. Чтобы 

замкнуть дорожку, просто щелкните на первом узелке, с котороо вы начали. С помощью 

же инструмента Freehand можно нарисовать плавную линию точно так же, как если бы 

вы делали это пером или карандашом. 

Натуральное перо 

 

Новый инструмент Natural Pen позволяет рисовать замкнутые дорожки одним 

движением руки. Этот инструмент предназначен для того, чтобы имитровать фломастер 

или авторучку. Он может работать в четырех режимах, которые выбираются с помощью 

панели свойств. 

 В режиме Fixed width (Фиксированная толщина) можноо рисовать кривые, 

имеющие одинаковую толщину по всей длине (аналогично линиям, которые получают с 

помощью диалогового окна Outline Pen). Разница заключается в том, что объект, 

созданный с помощью инструмента Natural Pen, на самом деле является замкнутой 

дорожкой, которую можно заполнить. Процедура рисования дорожек фиксированной 

толщины с помощью этого инструмента выглядит следующим образом. Откройте 

вспомгательное меню инструмента Freehand Tool (Кривая) и выберите 

инструмент Natural Pen. Щелкните на кнопке Fixed Width Natural Pen Type 

(Натуральное перо фиксированной толщины) на панели свойств. Введите значение 

толщины в поле Natural Pen Width (Ширина натурального пера), которое находится на 

панели свойств. Поместите курсор в том месте, где должна начинаться кривая. Щелкните 



и переместите указатель мыши вдоль некоторой траектории наподобие рисования 

карандашом на бумаге. 

 В режиме Pressure (Чувствительное к нажиму) можно рисовать кривые, 

меняющие толщину в зависимости от нажима "пера" или от нажатия клавиш управления 

курсором на клавиатуре. Это позволяет имитировать эффект рисования от руки 

фломастером или авторучкой. Лучше всего работать в этом режиме, используя 

чувствительный к нажиму графический планшет; но можно также воспользоваться 

клавишами управления курсором, чтобы регулировать толщину линии. Процедура 

использования инструмента Natural Pen в режиме Pressure такова. Откройте 

вспомогательное меню инструмента Freehand Tool и выберите инструмент Natural Pen. 

Щелкните на кнопке Pressure Natural Pen Type (Натуральное перо - чувствительное к 

нажиму), расположенной на панели свойств. Поместите курсор в том месте, где должна 

начинаться кривая. Щелкните и перетащите указатель мыши вдоль некоторой траектории, 

как при рисовании карандашом на бумаге. Если вы работаете с мышью, то воспользуйтесь 

клавишами управления курсором (вверх и вниз), чтобы изменять величину нажима пера. 

Если же вы работаете с планшетом, просто меняйте нажим на него, как вы это делаете во 

время рисования от руки. 

 В режиме Calligraphic (Каллиграфическое) можно рисовать кривые, 

меняющие толщину в зависимости от направления линии. В результате можно добиться 

прекрасного каллиграфического эффекта. Процедура создания линий в этом режиме 

выглядит следующим образом. Откройте вспомогательное меню инструмента Freehand 

Tool и выберите инструмент Natural Pen. Щелкните на кнопке Calligraphic Natural Pen 

Type (Натуральное перо - каллиграфический тип), которая находится на панели свойств. В 

поле Natural Pen Width (Ширина пера) на панели свойств введите значение толщины. 

Введите значение угла в поле Natural Pen Nib Angle (Угол скоса натурального пера) на 

панели свойств. Если величина этого угла равна 0, то кончик пера будет расположен 

горизонтально, а если 90 - вертикально. Если же вы хотите, чтобы кончик пера был 

наклонен, введите значение от 0 до 360. Затем щелкните и перетащите инструмент вдоль 

некоторой траектории, как при рисовании на бумаге. 

 Режим Preset (Заготовки) позволяет рисовать кривые, меняющие толшину в 

зависимости от определенного типа линии, выбранного из раскрывающегося списка на 

панели свойств. Процедура рисования линий в режиме Preset выглядит следующим 

образом. Откройте всопомгательное меню инструмента Freehand Tool и щелкните на 

инструменте Natural Pen. Выберите тип кривой из списка Natural Pen Presets 

(Натуральное перо - заготовки) на панели свойств. Поместите курсор в том месте, где 



должна начинаться кривая. Затем щелкните и перетащите указатель мыши вдоль 

некоторой траектории, как при рисовании карандашом на бумаге. 

Размерные и выносные линии 

 

Для рисования размерных линий в Corel Draw предусмотрен инструмент Dimension 

(Размерная линия). Благодаря этому инструменту у вас есть много возможностей для 

создания технических рисунков, схем и простых чертежей. 

Чтобы нарисовать размерную линию, выберите ее тип на панели свойств -

 horizontal (горизонтальный размер), vertical (вертикальный размер) 

и diagonal (наклонный размер), а затем щелкните в том месте, где должна начинаться 

линия. Щелкните еще раз там, где линия должна заканчиваться, а затем там, где будет 

находиться текст. Три типа размерных линий показаны на рис.2 

 

Рис.2 Типы размерных линий 

Две другие опции, находящиеся с правой стороны панели свойств, - это Callout 

(Выносная линия) и Angular Dimension (Угловой размер). С помощью выносной линии 

можно привлечь внимание к определенному объекту на рисунке. Выносная линия 

создается точно так же, как и все остальные размерные линии. Сначала щелкните в 

начальной точке линии, а затем - в конченой. Щелкните еще раз там, где должен 

находиться текст. А теперь можете его ввести. Опция Angular Dimension позволяет 

создавать угловые размерные линии (рис.3). Чтобы воспользоваться ею, сначала щелкните 

в точке, где должна находиться вершина угла, затем в точке, от которой будет начитанься 

отсчет угла, и наконец в точке, где он будет заканчиваться. Теперь щелкните в том месте, 

где должен находиться текст. Введите текст - и все! У вас получилась угловая размерная 

линия. 

 

Рис.3 Угловая размерная линия 

Прямоугольники и квадраты 



 

С помощю инструмента Rectangle (Прямоугольник) можно нарисовать 

прямоугольники и квадраты. При выборе инструмента Rectangle, как и при выборе 

прямоугольника с помощью инструмента Pick, на панели свойств будут отображаться 

одни и те же опции. Хочу отметить одну замечательную возможность: округлить углы 

нарисованного прямоугольника можно либо с помощью бегунка Rectangle Corner 

Roundness (Округление углов прямоугольника), либо введя нужное значение в 

поле Rectangle Corner Roundness. 

Эллипсы и окружности 

 

С помощю инструмента Ellipse (Эллипс) можно нарисовать окружности, овалы, 

секторы и дуги. При выборе инструмента Ellipse, как и при выборе эллипса с помощью 

инструмента Pick, на панели свойств будут отображаться одни и те же опции. Очень 

удобно то, что теперь с помощью панели свойств можно переключаться между режимами 

рисования эллипса, сектора и дуги, не открывая диалоговое окно. 

Многоугольники 

 

Используя инструмент Polygon (Многоугольник) можно рисовать многоугольники 

и даже звезды "одним движением руки" (вернее, мыши). Этот инструмент позволяет 

выбирать форму, число ее сторон и вершин, а также устанавливать такой параметр, как 

остроконечность, с помощью панели свойств. При выборе инструмента Polygon, как и при 

выборе многоугольника с помощью инструмента Pick, на панели свойств будут 

отображаться одни и те же опции. 

Если вы уже пытались рисовать спираль с помощью мыши или чувствительного к 

нажиму планшета, то, без сомнения, по достоинству оцените инструмент Spiral 

(Спираль). С помощью панели свойств можно установить некоторые параметры спирали, 

например число витков и величину сжатия. Эти же параметры можно задать во 

вкладке Spiral Tool (Инструмент Спираль) диалогового окна Options (команда 

ToolsOptionsToolboxSpiral Tool). 

1. Сделайте конспект материала 

2. Сформулируйте цель практикума 

 

Практикум №13 

 



Тема: «Создание декоративного текста» 

Цель: 

Терминология 

Прежде чем начать работу введем некоторые понятия. 

Гарнитура (tapeface) - это стиль текста, напрмер Times или Helvetica. 

Большинство гарнитур имеют в основном четыре стиля: нормальный (normal), в 

зависимости от гарнитуры "Roman" или 

"Book"; bold (полужирный); italic (курсив) и bold-italic (полужирный курсив). Некоторые 

гарнитуры имеют один - - два стиля; а некоторые, такие как ITC Gody Sans, - восемь и 

более стилей. 

Шрифт (font) - это буквы, цифры, различные символы, применяемые для набора 

текста; каждый шрифт имеет набор атрибутов. 

Размер в пунктах (point size) - это единицы измерения, в которых обычно 

выражается высота текста. Один дюйм равен приблизительно 72 пунктам. 

Гарнитуры 

Гарнитуры с засечками и без засечек 

Большинство гарнитур делятся на два типа: с засечками и без засечек. Засечки 

(serifs) - это основания на концах основных штрихов символов. Для основного текста 

следует выбирать именно гарнитуры с засечками, так как они лучше воспринимаются 

зрительно. А в случае шрифта большого размера гарнитуры с засечками выглядят более 

декоративно. 

(Примеры шрифтов: Times, Palatino, Garamond, ) 

Ко второму типу шрифтов относятся гарнитуры без засечек (sans serif) . По 

традиции гранитуры без засечек используются для заголовков и подзаголовков. 

Некоторые из них подходят для основного текста небольшого объема, придавая ему 

современный стиль, но не стоит использовать гарнитуры без засечек для текста , 

занимающего нескольно страниц, так как его будет просто трудно читать. (Примеры 

шрифтов: Avant Gard, Futura, Helvetica Black). Разница между гарнитурами показана 

на рис. 1 

  

 



Декоративные гарнитуры 

Декоративные гарнитуры могут быть элегантными и изысканные или нарочисто 

простыми, но в целом они обычно затрудняют чтение. Они подходят для простых 

коротких заголовков, для основного текста не годятся. Такие гарнитуры можно 

использовать для объявлений, листовок, приглашений, извещений и заголовков 

рекламного проспекта 

(Примеры шрифтов: Bernard Tango, Brush Script). 

Фигурный текст 

CorelDraw предлагает множество различных операций обработки фигурного 

текста: например, закрашивание, заполнение шаблонами или градиентное заполнение, 

вытягивание, выдавливание или применение эффекта перехода. Чтобы ввести текст этого 

типа, щелкните на инструменте Text (Текст). В результате курсор превратится в крестик. 

Щелкните в том месте, где должен находится текст и введите его. Затем вы сможете его 

отредактировать и выполнить над ним множество операций. 

Если выбрать текст инструментом Shape (Фигура), то возле каждого символа 

появиться узелок, а вокруг блока текста - маркеры управления расстоянием, 

представляющие собой две стрелки, направленные вниз и вправо. Одтельные символы 

можно переместить с помощью манипуляций над узелками, создавая эффект "скачущего 

текста". А чтобы изменить расстояние между символами или словами, нужно 

воспользоваться маркерами. 

Изменение расстояния между символами и словами 

Чтобы увеличить или уменьшить расстояние между символами, нужно перетащить 

правый маркер соответственно вправо или влево. 

Рисунок 2 

Чтобы увеличить расстояние между словами, нажмите клавишу и, удерживая ее 

перетащите правый маркер влево 

Рисунок 3 

Изменение расстояния между строками 

Чтобы увеличить или уменьшить расстояние между строками текста, перетащите 

левый маркер соответственно вниз или вверх. 

Рисунок 4 

Расстояние между словами и строками текста можно изменять также с помощью 

опций вкладки Space (Интервалы) диологового окна Format Text (форматирование текста), 

которое можно вывести с помощью команды Text ->Format Text (Текст - > Форматировать 

текст), а также из диалогового окна Edit Text (Редактирование текста) щелчком на кнопке 



Format text (Форматировать). С помощью инструмента Shape можно редактировать "на 

глаз", а опции вкладки Space используются, когда необходимо ввести точные значения. 

Перетаскивание символов относительно базовой линии 

С помощью инструмента Shape можно сместить отдельные группы символов (или 

группы отдельных символов) относительно базовой линии, чтобы получить специальные 

эффекты. Базовая линия (baseline) -это воображаемая линия , проходящая через нижние 

точки букв, за исключением выносных элементов (например через нижние точки 

букв а и х, но не p и q). Для перемещения одного символа выберите узелок, 

расположенный слева от него. Для перемещения группы символов выберите 

расположенные слева от них узелки с помощь шатра или нажмите клавишу и щелкните на 

каждом узелке. Пример перетаскиван текста относительно базовой линии с помощью 

инструмента Shape показана на рисунке 5 

  

Подгонка текста к дорожке 

Опция Fit to Path (Текст вдоль кривой) используется в основном при создании 

фигурного текста для логотипов и других изображений. 

Чтобы подогнать текст к дорожке, сначала введите его и выберите нужные 

атрибуты - шрифт, размер и т. д. Затем нарисуйте дорожку. Дорожку можно выбрать из 

любого другого рисунка, а также воспользоваться символом , картинкой или взять букву, 

преобразованную в кривые. Создав текст и дорожку, выберите оба этих объекта, затем в 

меню Text выберите команду Fit Text to Path (Текст вдоль кривой). Рисунок 6. Чтобы 

изменить положение текста на дорожке выберите опцию из списка Text Placement, 

расположенного на панели свойств. 

  

Пошаговая инструкция (Подгонка текста к дорожке) 

1. Наберите текст, который хотите подогнать к дорожке. 

2. С помощью инструмента Ellipse (Эллипс) (или другого) нарисуйте дорожку. 

3. С помощью инструмента Pick выберите текст и дорожку шатром. 

4. Выберите команду Text - > Fit Text to Path 

5. В раскрывающемся списке Text Placement, расположенном в панели свойств 

(третий слева), выберите нужную опцию. 

Пример: С помощью опции Horizontal Offset, находящейся на панели свойств, 

можно точно определить, где должен начинатся текст на дорожке. Рисунок 7. 

Пример: Чтобы изменить положение текста на дорожке, выберите опцию из списка 

Text Placement, расположенного на панели свойств. Рисунок 8. 



Пример: В случае изменения формы дорожки текст приспособиться к ней Рисунок 

9. 

Пример: Если вы хотите расположить текст на обратной стороне дорожки, 

активизируйте опцию Place Text Other Side на панели свойств. Рисунок 10. 

Пример: Чтобы набрать текст прямо на дорожке, просто щелкните на ней 

инструментом Text и введите текст. Рисунок 11. 

Преобразование текста в кривые 

Преобразование в кривые переводит текст в графический режим - у него сразу 

появляются узелки и другие атрибуты графики. Это позовляет изменить форму текста с 

помощью инструмента Shape (над обычным текстом это сделать невозможно). Текст 

преобразованный в кривые, не может стать снова текстом. 

Чтобы преобразовать текст в кривые, просто выделите строку текста и выберите 

команды Arrange - > Convert to Corves (Монтаж - > Преобразовать в кривую). 

Пошаговая инструкция (Преобразование текста в кривые) 

1. Наберите текст, который вы хотите преобразовать в кривые. 

2. Установите ВСЕ нжные атрибуты - трифт, размер, и т. д. 

3. Выберите команду Arrange - > Convert to Corves. Теперь над текстом можно 

делать практически любые операции. 

4. Выберите инструмент Shape. 

5. Выберите команду Arrange - > Break Apart (монтаж - > Разъеденить). В 

результате текст превратиться в набор независимых элементов, которые можно 

редактировать по отдельности. 

6. Выполните любые манипуляции с узелками. 

7. Заполните рисунки по своему желанию. 

рис.12 

 

Простой текст 

Простой текст (или текстовый аобзац) в отличие от фигурного (или 

художественного) обычно представляет собой текст большого объема. Чтобы ввести 

простой текст, выберите инструмент Text, а затем щелкните и перетащите его. Когда вы 

отпустите кнопку мыши, на экране появиться рамка, в левом верхнем углу вы увидите 

курсор. Текст можно ввести прямо в этом фрейме, импортировать из файла или вставить 

из буфера обмена. Простой текст можно переместить в любое место на странице. Простой 



текст в Corel Draw обладает теми же свойствами, что и текстовые блоки из других 

программ, таких как Microsoft Word. 

Форматирование текста с помощью стилей 

Corel Draw поддерживает два типа текстовых стилей: фигурный текст и простой 

текст. Стили определяются в докере Graphic and Text (Графичексие и текстовые стили). 

Чтобы создать стиль, выберите команду New (создать) из всплывающего меню докера. 

Существуют три способа создания нового стиля. Первый: выделите текст с атрибутами, 

которые вы хотите включить в новый стиль, а затем выберите команду New из 

всплывающего меню докера Graphic and Text. Второй: выберите из всплываещго меню 

докера команду Copy Properties From (Копировать свойства), а затем щелкните на абзаце, 

содержащем атрибуты, которые вы хотите включить в новый стиль. Третий: 

воспользуйтесь контекстным меню. 

Каким бы способом вы ни воспользовались CorelDraw создаст новый стиль и 

добавит его к списку стилей докера. Рисунок 13. 

Пошаговая инструкция (процесс создания и использования текстовых стилей). 

1. Введите текст, на основе которого вы будете создавать стиль. 

2. Отформатируйте текст, так 

как вам нужно. 

3. Щелкните правой кнопкой 

мыши на тексте, на основе которого вы 

хотите создать стиль, чтобы вызвать 

контекстное меню. Затем выберите 

команду Styles - > Save Styles Properties 

(Стили - > Сохранить свойства 

стиля) Рисунок 14. 

4. Введите имя нового стиля в 

диалоговом окне Save Style As (Сохранить 

стиль как) как показано на рисунке 15. Можно изменить свойства нового стиля, открыв 

папку и выбрав соответсвующие атрибуты. 

5. Щелкните на кнопке ОК. 

Чтобы переименовать стиль, выделите его в докере Graphic and Text, щелкните 

правой кнопкой мыши и выберите команду Rename (Переименовать). Для 

импортирования стилей из другого шаблона выберите из всплываюего меню докера 

Graphic and Text команду Template - > Load (Шаблон - > Загрузить), а затем выделите 

нужный шаблон. 



Если вы определили стили в стандартном наборе стилей CorelDraw, то они станут 

частью стандартной настройки нового документа. Создав новый стиль, вы должны 

сохранить его под новым именем, выбрав из всплывающего меню докера Graphic and Text 

команду Template - > Save As (Шаблон - > Сохранить как). 

Применение оболочки к простому тексту 

При использовании "оболочки" текстовый абзац помещается в так называемый 

контейнер, форма которого может имзеняться с помощью опций каталога Envelope 

(Оболочка). Причем, можно сделать так, чтобы форма превратилась в звезду, 

восьмиугольник и т.д. Вы можете сами создать оболочку или воспользоваться уже 

существующей формой. 

Чтобы применить оболочку, сначала создайте или импортируйте блок простого 

текста. Затем, с помощью опций каталога Envelope поместите текст в контейнер. А теперь 

измените форму контейнера в соответствии с типом выбранной оболочки. Существуют 

четыре типа оболочек. В этом разделе мы только в общих чертах рассмотрим как с 

помощью оболочек изменить форму простого текста. Более полное описание данного вы 

найдете в главе "Эффекты". 

Пошаговая инструкция (изменение формы текстового блока с помощью 

оболочки). 

1. Наберите или импортируйте текст, форму которого вы хотите изменить. 

2. С помощью опций диалогового окна Format Text (Форматирование текста) 

(команда Text - > Format Text) выберите для текста нужные атрибуты. 

3. Измените форму рамки вокруг текста, чтобы он помещался в ней 

наилучшим образом. 

4. Выберите команду Effects - > Envelope (Эффекты - > Оболочка), чтобы 

активизировать каталог Envelope (Оболочка). 

5. В каталоге Envelope щелкните на кнопке Add New (Создать новую). 

6. Выберите тип оболочки, соответсвующий одной из четырех кнопок, или 

щелкните на кнопке Add Preset (Добавить заготовку) и воспользуйтесь одной из 

стандартных оболочек. Чтобы выбрать в качестве оболочки некоторую форму (это 

обязательно должна быть замкнутая дорожка), щелкните на кнопке Greate From (Создать 

на основе) с изображением пипетки, которая находится в левом нижнем углу каталога. 

Для выполнения этой операции сначала выберите текст, затем щелкните на кнопке с 

изображением пипетки, а потом на форме, на основе которой вы хотите создать оболочку. 

7. Выбрав оболочку, можете изменить ее форму по своему желанию. 



8. Когда закончите изменять форму оболочки, щелкните на кнопку Apply 

(Применить). 

 

Рис 16 Рис 14 

 

Рис 13 Рис 11 

 



 

Рис 10 Рис 6 

 

 

Рис 5 Рис 4 

 

Практикум №14 

 



Тема: «Создание изображений в технике свободного рисования» 

Цель: 

Практическое задание: нарисуйте изображение на свободную тему 

Результат покажите преподавателю. 

 

Практикум №15 

 

Тема: «Создание визитки» 

Цель: 

Практическое задание 

Шаг 1. 

Запустите программу Corel Draw. 

Создайте новый пустой документ File > New, (Файл > Новый) (как показано на 

рис.1 ниже). 

Размер Вашего файла должен быть таким: width (ширина) - 95 mm, height (высота) - 

55 mm. 

 

Рис. 1 

 

Рис. 2 

Шаг 2. 

Разработка Вашей визитки. 

Ваш пустой документ должен быть примерно таким как на рис. 3 ниже. 

Растените Ваше любое фоновое изображение полностью до края. 



Вы должны оставить место под порезку - по 2.5 mm с каждой стороны. 

Примечание - расстояние от важных изображений (текст, логотип) до края изделия 

(места последующего разреза) должно быть не менее - 4-5 mm. Размер же от края макета в 

программа Corel Draw до ключевых элементов визитки (текста и рисунков) должен быть 

не менее 7мм. 

 

Рис. 3 

Шаг 3. 

Перевод текста в кривые и сохранение визитки. 

После того, как Вы сделали свою визитку, Вам необходимо перевести текст в 

кривые и сохранить Ваш файл в формате - .cdr. 

Выберете Edit > Select All>Text, (Редактирование > Выбрать все>Текст) 

 

Выберете Arrange > Convert to curves, (Упорядочить > Преобразовать в кривые); -

после выполнения этой команды все тексты вашей визитки станут векторными кривыми, 



и будут корректно отображатся на любом компьютере, независимо от установленных на 

нем шрифтов. 

 

Выберете File > Save As..., (Файл > Сохранить, Как) и выбирите формат - CDR из 

всплывающего меню. На рисунке 5 показаны опции, которые необходимо установить для 

наиболее корректного сохранения созданной вами визитной карточки. А именно - версию 

9.0, тип CDR, и имя файла (желательно использовать вашу фамилию и город, например 

Евгений-Донецк.CDR). 

 



Рис. 4 

 

Рис. 5 

 

 

 

 

 



 

 

 

Практикум №16 

 

Тема: «Создание поздравительной открытки» 

Цель: 

 

1. Сбор материалов в Corel CONNECT 

Начнем со сбора графических элементов и изображений, которые смогут нам 

пригодиться. Для поиска материалов в Corel CONNECT воспользуемся ключевым словом. 

1. Запустите Corel CONNECT как отдельное приложение или откройте окна 

настройки Connect и Лоток в CorelDRAW X7 (Окно > Окна настройки). Активируйте 

все фильтры (Папки, Файлы векторных изображений, Файлы растровых 

изображений и Файлы шрифтов), затем в верхней части окна в адресной строке введите 

ключевое слово снег и нажмите Enter. 

2. Содержимое подборки изображений и векторной графики на тему «снег», 

которую в результате предложит CONNECT, будет зависеть от ого, какие флажки поиска 

были установлены на панелях Библиотеки и Избранные папки. Кроме того, если у вас 

есть фотография вашего сада зимой, которая находится за пределами Corel CONNECT, 

этот снимок можно также перетащить в Лоток. 



 

3. Перетащите все нужные для проекта элементы в Лоток, который находится 

в нижней части экрана. Примечание: изображения и картинки, помеченные значком S, 

доступны для обладателей стандартного членства CorelDRAW; материалы со 

значком P доступны только для пользователей, имеющих расширенное членство 

CorelDRAW. 

4. Давайте сменим ключевое слово снег на Санта-Клаус. Перетащите любые 

понравившиеся картинки в Лоток. 

5. Мы перетащили элементы из других папок Clipart в Лоток. Получилась 

подборка, состоящая из стоковых фотографий, а также графики и изображений из 

коллекции дополнительного контента в CorelDRAW Graphics Suite. 

 

2. Разработка дизайна открытки в CorelDRAW X7 

Теперь, когда все материалы подготовлены, приступим к созданию дизайна 

открытки. 

1. Откройте новый файл в CorelDRAW: Файл > Создать… (Ctrl+N). 

2. Для размера страницы мы выбрали опцию «Фото» в альбомном формате. 

Разумеется, вы можете выбрать любой другой вариант. 



 

3. В CorelDRAW щелкните значок Быстрая настройка, чтобы открыть Окна 

настройки. Установите флажок Лоток, чтобы открыть это окно. 

 



4. Перетащим фоновое изображение из лотка на документ. 

5. Поскольку оно гораздо больше самой открытки, необходимо изменить 

разрешение изображения. Для этого выберите Растровые изображения > Изменить. 

6. В диалоговом окне Изменить разрешение установите разрешение на 300 

т/д в том случае, если вы собираетесь печатать открытку в типографии. Для печати в 

домашних условиях хватит и 150 т/д. 

7. Теперь изменим Размер изображения (ширину и высоту) в соответствии с 

размером открытки. Не убирайте флажок Сохранить пропорции, так как в результате 

изображение может исказиться. Лучше установить чуть больший размер с правильными 

пропорциями, а затем просто обрезать лишнее. Итак, установим ширину около 180 мм. 

 

8. Щелкните OK и нажмите клавишу P, чтобы отцентрировать изображение. 

9. Выберите Вид > Каркас и обрежьте изображение в соответствии с размером 

страницы (Набор инструментов > Обрезка). Чтобы точно обрезать изображение по 

размеру страницы, на стандартной панели инструментов в верхней части экрана 

под строкой меню снимите флажок Привязать к > Привязка к объектам и установите 

флажок Привязка к странице. По окончании снимите флажок Привязка к странице и 

снова установите флажок Привязка к объектам. 

10. Теперь давайте нарисуем темную рамку вокруг изображения, которая затем 

станет фоном для декоративного обрамления открытки. Дважды щелкните 

инструмент Прямоугольник в наборе инструментов, чтобы создать рамку. 

11. В окне настройки Диспетчер объектов видно, что рамка располагается 

ниже растрового изображения. Перетащите рамку так, чтобы она располагалась над 

растровым изображением. 

12. С помощью инструмента Цветовая пипетка в наборе 

инструментов возьмите образец темно-серого цвета в фоновом изображении и щелкните 

рамку, чтобы залить ее этим цветом. 



13. Нажмите + на цифровой клавиатуре или используйте сочетания 

клавиш Ctrl+C/Ctrl+V для копирования и вставки прямоугольника обратно. Залейте 

второй прямоугольник белым цветом и, удерживая Shift +, измените его размер таким 

образом, чтобы снаружи получилась рамка серого цвета. 

14. Выделите оба прямоугольника и щелкните Упрощение на панели свойств. 

 

После выполнения команды упрощения удалите белый прямоугольник. У вас 

должна получиться серая рамка. 

 

15. Чтобы добавить праздничное обрамление, перетащим векторную рамку из 

Corel CONNECT на страницу. 

16. Естественно, нам нужно будет изменить ее размер и поворот. Поскольку мы 

имеем дело с векторной графикой, просто добавим Поворот на 90° на панели свойств и 

нажмем клавишу P, чтобы отцентрировать рамку на странице. Затем, удерживая Shift, 

можно изменить размер рамки, сдвинув ее внутрь; качество изображения при этом не 

пострадает. 

Перетаскивание декоративной рамки на документ. 



 

Рамка после поворота на 90° и изменения размера. 

 

17. Теперь изменим цвет листьев так, чтобы он сочетался с тоном фоновой 

рамки. Для этого выберем Правка > Поиск и замена > Найти объекты. 



 

18. В диалоговом окне Мастер поиска выберите Начать новый поиск > Next. 

19. Щелкните вкладку Заливки и выберите пункт Однородный цвет. 

20. На следующей странице выберите опцию С конкретной однородной 

заливкой и используйте инструмент Пипетка 

 

21. Щелкните Next > Finish > Найти все и выберите Да при появлении запроса 

на разгруппирование объектов. 

22. На цветовой палитре выберите подходящий темно-зеленый цвет (элементы 

листьев при этом должны быть выделены). 



 

23. Не забывайте время от времени сохранять ваш документ (Ctrl+S), особенно 

при работе над длительным проектом. 

24. Теперь, поскольку элементы нашего дизайна выглядят плоскими, добавим 

эффект объема. Выделите серую рамку, активируйте инструмент Тень в наборе 

инструментов и выберите заготовку Плоский внизу справа. 

 

25. Вместо перемещения тени разъединим тень и объект (CTRL+K). Это 

позволит нам изменять размер и положение тени таким образом, чтобы она находилась 

только внутри рамки. После разъединения тени и объекта, изменения размера тени и 

центрирования у нас должна получиться тень, располагающаяся по внутреннему краю 

рамки. 



 

26. Теперь займемся картинкой Санта-Клауса, которая дожидается своей 

очереди в лотке. 

27. Изменим размер картинки и выделим ее. Вернемся к инструменту Тень, 

на панели свойств в списке выберем Перспектива внизу справа и с помощью 

интерактивного маркера расположим тень. 

 

28. Самое время добавить текст. Чтобы найти подходящий шрифт, откройте 

новое окно настройки Применение шрифта: выберите Текст > Применение 

шрифта или откройте окно напрямую, нажав кнопку Быстрая настройка на панели 

окон настройки. 

29. В открывшемся окне Применение шрифта замените текст, установленный 

по умолчанию, на фразу «Счастливых праздников!». 



 

30. Теперь можно по очереди выделять шрифтовые панели для выбора нужного 

шрифта в списке шрифтов. 

31. После выбора нескольких подходящих кандидатов их нужно просто 

перетащить на открытку, чтобы оценить результат. 



 

32. Мы заметили, что в группе наших кандидатов шрифты Alize и Gabriola 

содержат несколько стилистических наборов (наличие дополнительных стилистических 

наборов в шрифтах OpenType зависит от того, что было интегрировано производителем в 

конкретный шрифт). 

33. Для просмотра доступных стилистические наборов нужно просто выделить 

текст и щелкнуть черную стрелку внизу. Примечание: при работе с дополнительными 

стилистическими наборами можно выделять только одну строку текста за раз. 



 

34. Выберем Gabriola > Стилистический набор 7 и удалим остальные 

образцы. 

 

35. Чтобы сделать текст более заметным, вернемся к инструменту Тень и 

выберем Небольшое свечение в списке заготовок на панели свойств. 

36. Установим Непрозрачность тени на 100%, понизим Размытость 

тени до 8 и изменим цвет свечения на белый, чтобы эффект свечения был более заметен. 



 

37. Разумеется, вы можете добавить текст или изменить его по вашему 

усмотрению. Открытка готова! 
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